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SMath is a program for performing and documenting engineering calculations. An SMath
document consists of formulas, texts, diagrams, and images freely arranged on the page.
Formulas can be assembled from calculator-like palettes or from the keyboard without
using the mouse (much faster for experienced users). There is excellent support for units of
measurement. The formulas serve as both computational instructions and documentation.
Formulas appear in natural mathematical notation (not like program code), allowing even
those unfamiliar with the program to understand them.

SMath originated as a hobby project by Andrey Ivashov, a software developer from Saint
Petersburg. It is now developed and supported by LLC SMath (OOO Dcwmar), of which
Andrey Ivashov is the managing director. The program gained significance within the
context of the sanction relief efforts for the Russian economy and science, as it can replace
the conceptually similar MathCAD by PTC (USA).

SMath is closed source commercial software. There is a free personal license plan (requir-
ing registration). This plan has no restrictions of the mathematical features but does not
include commercial use.

SMath features an integrated extension manager. This provides access to an online gallery
where the community can publish program extensions (plug-ins), application examples,
documentation, and code snippets. The present manual is also available there.

The author of this manual has extensive experience in using SMath Studio for research
and teaching at the University of Applied sciences Brandenburg (THB) in Brandenburg an
der Havel, Germany. He is active on the user forum at smath.info. Major contributions to
the community are a comprehensive German handbook (Kraska ) and the Maxima-
plugin, an interface to the free and open-source computer algebra program Maxima. This


https://smath.com/
https://smath.com/en-US/view/SMathStudio/contacts
http://smath.info
https://maxima.sourceforge.io/de/index.html

CHAPTER 1. INTRODUCTION

interface provides features such as symbolic integration and equation solving, as well as
three-dimensional diagrams. This is what could be Germany’s concept of success: Take
the best from East and West and combine it for the benefit of everyone.

SMath with Maxima is for those who want to go beyond what is possible with SMath
alone, yet benefit from the advantages of the user interface as the paper-and-pencil-like
document format and the support of physical units.

SMath with Maxima is more complex than SMath alone or as Maxima alone. Due to
the limitations of the interface, not everything possible in Maxima can also be done in
SMath via the plugin. Yet knowing both worlds and having access to Maxima from
SMath extends your toolset for efficient and smart handling of scientific and engineering
calculations.

This manual was written in parallel to a major rework of the Maxima Plugin and wants
to encourage SMath users to actually try it. It is still required to install Maxima on your
system (with admin privileges) but the Maxima plugin guides you through this process.
Using SMath with Maxima is just some mouse clicks away.

We assume that you are already familiar with SMath and have a working installation at
hand. Knowledge of Maxima would be helpful but is not mandatory.

Some chapters have file attachments (below the chapter table of contents). You can find
them in the attachment view of your PDF viewer.
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CHAPTER 1. INTRODUCTION

1.1 What You Get

Menu entry Main menu> Insert>Maxima

I@E Maxima L » ] Log
Debug

i Settings
e T " Draw2D
Draw3D
1 . Restart

This entry provides access to the Log and Debug Dialogs, the Settings form, Maxima
plot regions, called Draw2D and Draw3D regions and to the Maxima help page.

Maxima palette in the side panel for insertion of Maxima functions to the canvas.

Maxima =
a Control Define

Takeover Log X

Function Maxima(), which hands over expressions to Maxima for evaluation and returns
the result to SMath. The currently implenented translation capabilities already
cover a significant part of Maxima’s features. There is full support for units of
measurement, text indices and UTF8 encoding.

Symbolic alternatives to SMath Functions
e Int() for definite and indefinite integration

e Lim() for limits, also one-sided limits are supported by adding +’0 or -’0 (a
zero marked as unit) to the point.

e Diff () for derivatives
e Det () for determinants

e Sum() for sums

Cross() for cross products. It has a permanent operator form """

(smaller than the original SMath cross product symbol).

The function MaximaTakeover () redirects the native SMath functions to the above-
mentioned alternatives. The advantage of redirection is better readabilty by use of
the native operator symbols:

o SMath without Maxima

o

jsin[x]dx:jsin(x]dx L[\Sin[-‘f—ﬁ]dx=l

0 lastError="¢  not defined."™

sin [:{]II= sin(x }I

= 2 X X
._n +n lim = 1lim
E:J_ 2 x21+017% xs14017x%

1=1

lastError ="n - not defined."™

12
b 3

12
b 3

e SMath with Maxima and enabled redirection (takeover)
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HaximaTakeover["all":]—"d" ff{), int{), 1lim(), sum(), det() handled by Maxima"
jsin[x)dx:—cos (x) ISln x+gldx=2-cos(p) sin(x) =cos(x)
1]
n
[ X
| (3-2-b) “':1_‘1 lim =-m
B 3 x=>14+pl—=x

Wrapper functions for some Maxima features:

e Solve() symbolic solution of algebraic linear and non-linear equations and
systems of equations (chapter 7)

e ODE.2() symbolic solution of differential equations (chapter 8)

e Fit() for non-linear least square fits of data to parametric functions (chapter

6)
e MSE() mean square error between data and model

e Residuals() residuals between data and model

e Functions Draw2D() and Draw3D() for creating plots (chapter 3). These can be
displayed using Image regions (plugin ImageRegion). The functions use Maxima’s
draw package which actually uses Gnuplot as a back end.

e Draw regions (section (3.9)). They take the same commands as Draw2D() and
Draw3D() but provide interactive mouse control for sizing, scaling, rotation and
have a settings form for common plot options.

e Support of real and complex numbers, strings, lists and matrices.

Restrictions:
e The interface doesn’t work under Linux.
e No support for names containing special characters produced using .
e No units support for numerical procedures in Maxima.

e Boolean expressions are translated but have a different meaning in Maxima. Maxima
has a data type boolean, which can assume the values true or false. In SMath
this corresponds to numeric values zero for false and non-zero for true.

e There are restictions for the length of expressions due to the translation by regular
expressions.

e The Maxima plugin is in beta-state of development. Not everything works as ex-
pected and things may change in the future.

Maxima on the web:
e Maxima Homepage! on Sourceforge,
e Maxima Overview? Quick overview

e Official index of handbooks and tutorials®

!maxima.sourceforge.net

http:/ /www-com.physik.hu-berlin.de/ ~bunk/kurs /maxima/maxima.html
3http://maxima.sourceforge.net /docs/manual /de/maxima_ 12.html#SECT9

Martin Kraska 8 2023-09-29
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1.2 Installation of the Plugin

Just like any other extension, the Maxima plugin is installed via the Extensions Manager
from within an SMath session:

e Tools> Plugins
e Make sure to switch to the online gallery and unselect “exclude beta versions™

Extensions Manager X
¥ SMath Studi = .
Hee r/— Pluglns L&r Online gallery
4 A ——
¢ Handbooks :
D Examples Beam Analysis Utility Funchons Local storage
by Redam £ egazor Jr v| Online gall
) gallery
Interactive books ? Extends SMath Studio with ENGINEERING FU
. Plugins — - Exclude beta-versions
‘::@ Applications Big Integer Anthmebcs 0.1.7673.25195
Sninpets B ovedond 56,78KB
PP ? Collection of Big Integer Anthmehic functions for SMath Studio. iy
Ed Translations —

e Select the MaximaPlugin from the list.
e Press |Install | and wait for the installation of the plugin.
Usually, there is no need to perform a restart of the SMath application.

When the installation is finished, the “Settings” dialog pops up. Otherwise you can call
the dialog via Insert> Maxima> Settings from the main menu.

ol Settings — O X
Install Maxima
Installed Version: 5.47.0
Latest available version online:  5.47.0 Instal
Maxima installation requires active intemet connection and admin rights
Path to Maxima
" \maxima-5.47.0%bin
Specify a directory from where to search for maxima bat
Save Cancsl

Note: the plugin is just the interface between SMath and Maxima. Maxima is not included
in the plugin. You can point to an existing installation of Maxima or you can use the

Install | button. These options are described in the next section.

Martin Kraska 9 2023-09-29
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1.3 Installation of Maxima

Open the Settings dialog: Insert> Maxima> Settings

You already have a working Maxima installation on your computer?

1. Use the file selector ] to indicate the path to your installation. It is sufficient to
point to the top level directory, e.g. C:|\mazima-5.47.0.

2. Press . SMath starts searching for mazima.bat and tries to launch Maxima.
If that works, just confirm the message.

You don't have Maxima on your computer? For a standard installation you need
Internet connection and admin privileges. The installation will take slightly more than
700 MB of disk space.

Press |Install | and select one of the install options:

o=l Maxima Installation - ] b4

Select the type of the installation

(@ Silent installation
Automatic installation with default settings.

(") Manual installation
User-customizable installation. Default installation path iz recommended.

MNext

It should be safe to use the silent installation. In any case, the installation is a two-step
process: download and the actual installation. The software is downloaded using the
official links. SMath does not modify the installation in any way.

Upon finishing, the Settings window is closed and a Maxima session is launched in the
background. Check the Insert menu for a Maxima submenu

Ia! Maxima N >| Log
¥ Debug

1 Settings

Fam  wgw w mwm ' Draw2D
Draw3D
Restart

In the side panel you should find the Maxima palette with quick access buttons.

Maxima =
a Control  Define

Takeover Log X

Martin Kraska 10 2023-09-29
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1.4 Other Useful Plugins

Custom Glyphs provides nice operator forms for SMath functions.

Custom Functions provides the substitution function at (), which is very comfortable
to use with results of any kind of algorithms (solver, curve fit).

Development Tools provides convenient access to the installation directory of the Maz-
ima plugin. In this directory Maxima stores temporary graphics files and the
configuration file mazima.xml. Select Insert> Development Tools> Plugin’s
folder> MaximaPlugin.

ImageRegion provides a region for display of image files generated by Maxima’s Draw2D ()
and Draw3D () functions. This is the most transparent way to use Maxima plotting,
while using the Maxima Draw regions is more convenient.

Martin Kraska 11 2023-09-29
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1.5 The Maxima Session

As soon as any of the Maxima-based features is used in an SMath document, a Maxima
session is established via TCP/IP connection. You find this process as sbcl.exve (Steel
Bank Common Lisp) in the Windows task manager.

e Each SMath instance has it’s own Maxima process, which communicates with the
currently open SMath document.

e Once started, the Maxima session is kept open.

e The session can be reset using the function MaximaControl(). The argument
"restart" closes the session and starts a new one. The Argument "cleanup"
just let’s Maxima forget defined variables and loaded packages.

MazximaControl [ ":esta:t"]= "Eestart complete."”

MaximaControl [ "u:'_ea:"_l_:p"]z "Cleanup complete.”

Alternatively you can issue a restart using Insert™> Maxima> Restart.

e Switching between open document in a single instance of SMath can have side
effects, because all documents of a given SMath instance share the same Maxima
process.

To be safe, insert MaximaControl ("restart")= in your documents before using any
Maxima feature. Opening just one sheet per SMath instance completely avoids the
problem.

e Save your work frequently. Maxima or SMath actually can crash. Usually, the
plugin manages to kill crashed Maxima sessions. If not, find and kill the process
sbel.exe (Steel Bank Common Lisp-Interpreter) using the Windows task manager.

Martin Kraska 12 2023-09-29
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1.6 Replacement of Functions (Takeover)

The interface is under development, so the redirection (takeover) of SMath native func-
tions by Maxima is deactivated by default. For activation and deactivation we have the
function

MaximaTakeover (). The function accepts one or more string parameters, which are searched
for the keys given in table 1.1 to redirect individual functions or “all” for all of them
(as you might guess). If none of these are found, redirection is deactivated.

This redirection can be done at any location in the SMath sheet and is valid until the next
call to MaximaTakeover (). It is also reset by restart or cleanup using MaximaControl ().
Note that the takeover state can only be changed by functions on the sheet, not by menu
commands like Insert > Maxima> Settings> Save or Insert>> Maxima> Restart.

Function Key SMath Operator Maxima
Derivative “diff”  diff(1) *® Diff (1)
1
d
1
aiff(2) " Diff (2)
1
d
1
aitf(3) <" Diff (3)

pdn
Indefinite integral “int”  int(2) j Int(2)

Definite integral  “int”  int(4) ' Int(4)
Determinant “det” det() ul Det ()
lim &
Limit “im”  1im(Q) = Lim()
I
L
Sum “sum” sum(4) 1= Sum(4)

Table 1.1: SMath functions and corresponding Maxima functions available via
MaximaTakeover (). The capitalized Maxima functions are always available,
yet they don’t have operator representations.

Symbolic results from Maxima can be displayed using Optimization> Symbolic or Opti-
mization> None in the context menu of the formula. In case of “Symbolic” SMath tries
to further simplify the result, not always to the better. It is sometimes worth a try to
switch off optimization.
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1.7 The Maxima() Function

This function

1. Takes an SMath expression (which SMath tries to handle before it is actually sent
to the function).

2. Translates it to Maxima syntax.
3. Uses this as input for the current Maxima session.
4. Translates the Maxima output to SMath

This is the most general way to use Maxima from within SMath. Frequently it is just
used to simplify SMath expressions.

Die Maxima () function has an operator form (Maxima logo), which in earlier versions was
provided by the Custom Glyphs plugin, but now is part of the Maxima plugin itself.

HaximaCDntIDl["restaxt"]::“aestart complete . ™
n a +h n L1 a+D L1
@E: ata | |2-a
Object SMath Maxima
Decimal separator Comma or period Period

Argument separator  Semicolon or comma Comma

Text index p a_h_b
. b
Underscores in names — a_b
Special constants e, 1 he, hi
]( 1
[
Lists (systems) (]
M
Matrices o matrix()
Element index J v[j]
Strings "HEgT "abc"
Units = %unitcm

Table 1.2: SMath objects and their representation in Maxima

Usually translation of names to Maxima and back to SMath should yield the original
name. The function MaximaLog() reveals what happens behind the scene. It shows the
most recent input/output pair of the Maxima session.

"BEeceived Bytesz: 27
MaximaLog (#)= (3122) [$a+bs,2*a];
(2022) [Sa+khs,2*a]"

To inspect the translation steps use the debug window under Insert> Maxima> De-
bug.
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1.8 The Log Window

The communication between SMath and Maxima is logged by default. The log window
is called either from the canvas by MaximaLog("big") or via Insert> Maxima> Log.

ol Log - O ot
Log type Options

(@ Maxima communication ] Always on top Refresh

() Full conversion Sal'n.;eg a8
O W Clear

pid=16348 A
Loading C:/Users/kraska/maxima/maxima-init.mac

Maxima 5.47.0 https://maxima.sourceforge.io

using Lisp SBCL 2.3.2

Distributed under the GNU Public License. See the file COPYING.
Dedicated to the memaory of William Schelter.

The function bug_report() provides bug reporting information.

(%011} display2d:falsed

(%i2) linel:700%

(%013} simpsum:true} v

There are three types of logs:

e Maxima communication: This is a concatenation of the strings exchanged be-
tween SMath and Maxima

e Full conversion: For each request to Maxima, this log shows
— The SMath expression in text format
— The translation to Maxima
— The response from Maxima
— The translation to SMath in text format

e wxm: This contains the commands sent to Maxima formatted as wxMaxima input.

The button offers a dialog to save the log. In the case of wxm format, the log
is sent to wxMaxima (the standard GUI of Maxima).

M owxMaxima 21.05.2 (Windows 10 (build 19043), 64-bit edition) [ commandsawxm ]

File Edit View Cell Maxima Equations Matrix  Calculus  Simplify  List
Plot uzing Draw X _—

D RED) linel:700%

Expression .

Implicit Plot simpsum:trues

Parametric Plot %
logsimp:true$

Points E g p
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1.9 MaximaLog()

MaximaLog(m)
shows the last input and output of Maxima with the respective labels.

MaximaLog("all")

displays Maxima input and output of the running Maxima session beginning from the
last restart or cleanup or manual log reset. The output may be quite large. In this case,
it is better to use the interactive Log window. This log is a simple concatenation of the
strings exchanged between SMath and Maxima.
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1.10 Where To Get Help

The Documentation of your current Maxima installation is available under Insert > Max-
ima> Help.

Comprehensive Material on Maxima is found on the web page of Edwin L. Woollett, in
particular the extensive 15 chapter tutorial “Maxima by Example” (Woollett )
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2.1 Algebra

Display of Maxima results is best with Context menu> Optimization™> None.

Factor and Expand

B 4 2
AL (factor (10!))=2 -3 -5 -7

3 2 2 3

=

ar

-

= &E[Expand [[x +v) 6]]

G 3 4 3 3 4 2 5

factor[xﬁ—l]]=[:{—1]-|:x—1}-[x2—x—1]-[x2—x—1

2
u=y —T+é&-x-y —+—15-x -y —+20-x -y —+—1%-x -y —T6&6-X ¥y TX

Complex Numbers

r:E[ratsimp [Ei-n” =—1

AT paiarfam[:;:il =el;
Re[ftx]]:RE[ﬁ @E[Re[f(x]]]=1_:_x
m (£ (x)) = m| ;A 8L (e () == ==

Big Floats

MaximaDefine() is used to set values in the background Maxima session.

usage is to set control variables:
fpprec Precision for floating point operations

fpprintprec Precision for output of floating point values

4 4
&E[expandvrt[[:{—y] ;x]]zy T—4-Xx-y¥ TE'X ¥ T4-Xx -yTX

A common
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MaximaDefine [ fpprec ; 48 ]| =48
0]
@E [bflc-at [E]I}I =2,718281828459045235360287471535266249775724 70937 - 10

E"E [fpprec] = 4B

Ifpprec == 3

MaximaDefine [ frorec ]l =3

OX (pricat (e))=2,72- 10°

E"'E [fpprec] =3

Cross Product

The native SMath cross product has two limitations: It can’t handle vectors which are
multiplied by undefined variables, because in contrast to Maxima, SMath doesn’t assume
that such a factor is a scalar. The other restriction is that it can’t handle 2D vectors.

2y b, d,-by—ag-b,
a = '52 b= b2 axh= aE-bl_al-bS
23 b, &,-by,—a,-b,

[Ai -a -Ag]x[Bl-b -BQ]=I

lastError = "Cross product can only be calculated for three-component -

lastError = "Crozss product can only be calculated for three-component -

94

2

The Maxima plugin provides two ways to handle this.

e Wrap the native cross product with the Maxima () function:
4,-4,B; -8B, '[az'ha _aa'hz]

ﬂ.[[ﬂi a-a,)x(B;b5,)| =4 ‘A,°B, "B,-(a;-b, ~a, b,
A, 'HE,-BI-BE-[aI-bZ—aE-El]

E.}E[:cxd:]=cl-d2—c2-dl

e Use the dedicated function Cross() with a permanent custom operator form (not
affected by MaximaTakeover () )
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Maxima =
a Control  Define
Takeover Log E

A -A_-B,-E
[Ai.a -AF]N[BI-E-BE]: a4, 'AQ'Bi'Bz'{aa'bi_ai'bs]
A -A_-B,L-B

cxdzcl-df—cf-dl

Eigenvalues

Maxima has functions for extracting eigenvalues and eigenvectors symbolically. For each
eigenvalue it’s multiplicity and eigenvectors are given in a nested list and matrix structure:

a—kb
_ z Bl b+a eigenvalues
rﬂ, eigenvaluss =
b a] 1 multiplicities
1
A a kb a—b
= =1aqe = A= m=
m: @E sigenvalues || %E: L {
A a o
= eigenvaluss A =4a m=42
g I el ]] { {

The Eigenvectors are returned as row vectors. For multiple eigenvalues the vectors are
returned as rows in a matrix.

eigenvalues and

multiplicities SIJEnveLion
)
BB 111
_ = 2. b+taa-b [ ]
@E eigenvectors || b a b ||]= 1 5 10 -1
B b a ) 01-—-1
T
a b b
[_A n]:= @E eigenvectors || b a b
E b a|
L=|2F2Pa-b [111]
1 2 n=|[10 -1
01 -1

There is also a numeric procedure for eigenvalue problems: eigens_by_jacobi(). It
returns a list of eigenvalues and the corresponding spectral matrix with it’s columns
being the normalized eigenvectors.

[1 -2 -2
A : . L
M>=-2 1 -2 & = rﬂ(slgsns_hy_jacshl [M:I]
| —2 -2 1
3 0,707 0,577 —0,408
A=4—3 &=|-0,7070,577 —0,408E
3 ] 0,377 0,Bla
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Note that the double assignment to A and ® requires the setting Optimization> sym-
bolic in the context menu. Otherwise the list structure of the result is flattened out and
the assignment fails.

The spectral matrix rotates the matrix to diagonal form with the eigenvalues populating
the diagonal
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2.2 Manipulations of Terms

args () extracts the arguments of a function.

An application is the conversion of a matrix into a list of lists (which is sometimes needed
for specifying graphics objects). In Maxima a matrix is represented as the function
matrix([...],[...]...) with the rows represented by lists. args() extracts the rows
of a matrix as a list of lists:

361

N 1886
M-—Raﬂdomy[z; 3:1; 6)=

ﬁ[args [M]:I=<

=om m e

"Received Bytes: 33
Maximalog[0)= ($¥162) args(matrix([1,6,6],[3,6,11)):
(2062) [[1l,6,€8],[3,6,1]]"

apply(f, list) converts the elements of list into arguments of function f.

&L | apply | £; =f(a:b;c)

[«

A combination of both functions allows to apply the rows of a matrix as arguments of a
function. Some graphics functions like 1abel () take arbitrary numbers of lists as argu-
ments. This is easy to generate from a matrix using the args () and apply() combination:

1 3
P_:E[apply[f; args [M]]]:f 6:46
& 1

The function ev() applies substitutions to an expression. This goes beyond the SMath
function at (), because it can replace complex expressions, not just variables:

3 2
svl|la +b+d: 3l=3+2-4d

=

& -
bB=d
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2.3 Calculus

Symbolic Derivatives

SMath can handle symbolic derivatives on it’s own. Should that fail in particular cases,
you can switch to Maxima. This also enables the prime operator form, which exists
in SMath but is not functional without the Maxima plugin. The function behind this
operator is diff ().

MaximaTakeover [“diff“]l= "diff() handled by Maxima"™

fx)=x+s=in(x) f{x}r:]__cns[xj

r:E[taylor[sinh[x];x;0;3]]=3_x__x__-'{_

Symbolic Integrals

Once the integral functions are taken over, SMath can handle indeterminate integrals
symbolically.

MaximaTakeover [“int“]l= "int () handled by Maxima"™

2-x —1

2 atan
1 dx:_ln[:{ —:-{—l]_ l .4'? _ln[x—l]

JoL 3 6 e 3

~

ln[xjadx=:{-[ln[:{]IS—S-ln{:{]E—E-ln[x]—E]

3 2 2

X T2-X —x—ld _ ln[x —l] ln[x—S] atan[x]
x—— —_— —_— —_

o 3 2 4 2 2

X +3-%x +x-+3

~

SMath will always try to handle determinate integrals numerically. Only if SMath fails,
the takeover by Maxima will take effect. If you want to enforce handling by Maxima, you
can use the capitalized function form Int(f, x, a, b).

Integral is handled by SMath (numerically)
1 2

2 _1
‘J‘x dx=0,3333 Int|=x ::{:U:l]—g
0

Integral is handled by Maxima only if SMath fails with numeric evaluation

3 3
2 ag I 2 _=
er dx = nt | x ,:{,U,&—T
0
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Symbolic Limits

SMath has a native limit operator, yet normally that is not functional. Takeover by
Maxima enables symbolic limits.

MaximaTakeover [“11m“]|= "lim() handled by Maxima"™
2 zin|x ) X ) 1
1lim sin[:{] =1 1lim —[]I=1 lim & =m lim —=m
o x=0 X X S x20%
Ha=
2
X i a
13m tan[x]zl w0 X %0 x
x>0 X

Single-sided limits are specified by adding -’0 or +’0 (a zero marked as unit) to the
limit point. Using plus/minus a simple zero was possible in early SMath versions. Yet
now there is no chance for the plugin to prevent SMath preprocessing from removing the
zero. However, marking the zero as unit does the trick.

zingle-=zided limits - ?
1 1
lim == =
x=+1+0l-% l h
lim 1 T e s

x21-0l-x
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The Maxima plugin provides access to Maxima’s draw package! Haager . It’s back-

end is the flexible and powerful open source graphics software Gnuplot? . The graphics
are saved in temporary or user-specified files.

Unique selling points of Maxima graphics:

e Logarithmic plots (which you otherwise would only get with the ZedGraph region,
which is very complicated to handle)

e Shaded 3D plots
There are two options to place Maxima plots on the sheet:

Draw functions and Image region The functions Draw2D () and Draw3D() produce 2D
and 3D plots respectively and return the file name used for storage. This name
goes to the placeholder of an Image region, a general purpose region for display of
graphics from files or matrix variables. This region is provided by the Image Region
plugin.

Use this for complete control by graphics commands.

Draw region These are dedicated Maxima plot regions, found under Insert> Max-
ima> Draw2D and Draw3D. They provide a setting menu and some moderate
(slow) interactivity for scaling and rotating plots.

Use this for convenience: Interactive sizing, scaling and rotation and less commands
required.

1 riotorto.users.sourceforge.net/Maxima /gnuplot
2www.gnuplot.info
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CHAPTER 3. PLOTTING WITH MAXIMA

Both options share the same graphics features. In both cases, the user provides a list of
objects and options to control the plot.

When demonstrating features, we mostly use the Draw2D () /3D() functions, because they
don’t have hidden settings.

The graphics can be produced as PNG, SVG or PDF files.

PNG is fastest but has sometimes visual glitches (incomplete display of characters)

SVG is good for export. Rendering on the canvas suffers from wrong text alignment in
the image region and noenhanced text mode in the Draw regions. This means that
texts like “a”b” and “c_ 2” aren’t handled correctly.

PDF Best option for high quality display and export.
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3.1 Your First Draw2D() Plot

1. Create an Image region. Insert> Image. A region with a placeholder appears.
The actual size of that region is not important for now.

2. In the placeholder, add the Draw2D() functions with a list of commands as argu-
ment.

Make sure to use the boolean equal for commands like title = My first plot”’

3. Leave the region (click next to it) to see the result. The default image size is 300 x
240 pixels in 2D and 300 x 300 in 3D. Yet the image is scaled to the actual size of
the image region.

4. Adjust the region to match the image size: Context menu (left mouse button) >
Reset to original size.

My first plot

0.5

0.5

Draw2D

{title ="My first plot"

explicit [sin[x]; X: —O: 11]

Plot commands consist of objects and options.

e Global options affect the whole scene. Their position in the command list is not
relevant.

e Local options affect subsequent objects. They must precede the object they are
supposed to affect.

The options have to be written as equations with the boolean equality symbol option=value.

In the Draw-Description snippet (see section 3.3) you find comprehensive information on
the available objects and options.

Some of the options are explained in the subsequent sections and demonstrated in the
examples for the graphics objects in chapters 4 and 5.
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3.2 Draw2D() and Draw3D() Functions

The functions Draw2D() and Draw3D() actually produce an image file and returns it’s
name. The image region takes a file name in the placeholder. This file is read and
displayed.

You can use additional arguments to specify a file name and the size of the graphics.

Draw2D ( commands )

DIEWZD[cammands; filename]

vidth
Draw2D | commands » £ |
height
B width
DrawlDl | command ; filename ;¢ .
heaght

commands List of objects and options.

filename (default: “pdf”) format and storage location of the graphics file. If just an

extension is given (“png”, “svg” or “pdf”), then a temporary file name is generated

in the specified format.

Relative filenames (without full path specification) are relative to the current direc-
tory. It is advisable to set the current directory to the document directory. This
yields portable documents.

prd :=CurrentDirectory [Dccument]jirectcry |: " "]]

pvd ="C:\FHE\Software'SMath'SMath Skripth\Images’"

width, height (default 300 x 240 for Draw2D() and 300 x 300 for Draw3D()) size of the
graphics file in pixels. In the Image region, the graphics is scaled to the size of the
region. Yet to keep consistent font sizes, do it the other way around:

e Specify size as needed in the draw function

e Adjust the region to match the image size: Context menu> Reset to orig-
inal size.
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3.3 The Draw-Descriptions Snippet

Creating graphics with Maxima is all about knowing the available objects and options.
SMath doesn’t know these by default, so that the dynamic assistant doesn’t help.

The Draw-Descriptions snippet (snippets are collapsible area regions with SMath regions)
contains dummy definitions with attached descriptions of all objects and options in Ger-
man and English. Once this snippet is inserted, the dynamic assistant knows them all.

Insert the snippet:
1. Set the cursor to where you want the snippet (it appears just as a thin line)
2. Open the snippets page of the extension manager Tools™> Snippet Manager

3. Locate and select the snippet “Draw Descriptions” in the list. If it is not there, you
might need to switch to the online gallery and get it from there.

4. Make sure to select “insert snippet inside Area Region” and press

Cluick search: | Title ~

Insert =nippet inside Area Region Cancel

The dynamic assistant knows about locally stored snippets. So it is easy to insert the
Draw-descriptions using the keyboard:

o) Draw i a Draw-Descrnptions (Maxima) - Makes

g Maxima Draw objects and options
& DrawlD known to the dynamic assistant

W ds Smipoet

Press Shift+TAB toinsert
Press TAB toinsent inside Arss Region

The snippet is inserted as a collapsed area region:

H—Draw-Descriptions (Maxima)

You can open the area region by clicking the and browse the available objects and
options. The real comfort of the snippet is that you avoid typos and get reference on
available arguments and options.

expl:|'.|

oF explicit (4) i ||[Maxima Draw2D] explicit(f,,xminxmed plots explict functionf,

3 axplicit (7) with variablex taking values from xmin to xmax. Options: nticks,
P adapt_depth, draw_realpart, line_width, line_type, key, filled_func,

T exportData csv (2) fill_colorand color

L7 exportData csv (3) explicit(_1; 2; 3; 4)=explicit(_1; 2; 3; 4)

[ exportData gpp (2) ¥
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3.4 Axes and Grid

The following images summarize the options for control of the axes and the grid. The
default values are given in blue.

title 7" (empty string) xtics_secondary false

xrange_secondary auto

axis_top true

‘ N N - xtics_secondary_axis false
i ™~ xtics_rotate_secondary false
L yaxis true 4
grid true yaxis_type solid
yaxis_width
j ;\ yaxis_color * |
2 | axis_left true axis_right true yticssecondary false
_(i yrange_secondaryauto
vtics auto . . e yt%cs,secondary,axis false
yrange auto xaxis solid ytics_rotate_secondary false
;\ytics,rotate false XaX}s,ty.pe dots 7 )
- ytics.axis false Xax¥s,w1dth xtics auto
| logy false xaxis_color | xrange auto
| xtics_rotate false
DE— Lot 1 1= ytics_axis false
proportional_axes none \ logx false
xlabel x
axis_bottom true
. o Angle between direction of view and north pole (+2)
title view { B Rotation about z
B x/y/zaxis false
ztics auto x/y/zaxis_type dots P
zlabel = zrange auto x/y/zaxis_-width
z ztics_axis false x/y/zaxis_color
| logz false =il
grid true

proportional_axes none
axis_3d true
xyplane auto

-+

xlabel x
ylabel

xtics auto v ytics auto

xrange auto yr.ange za.uuto

xtics_axis  false ytics_axis false
logy false

logx false

The grid is active by default for the x and y axes.

Text labels are produced in Gnuplot’s enhanced mode with full Unicode support (UTFS):
a_b yields a;, a~b yields a®.

This applies for all types of text:
e Axes labels (x1label, ylabel, zlabel, xlabel_secondary, ylabel_secondary)
e Title (option title)
e Text labels at arbitrary coordinates (object label()).

Note that you can show a polar grid with gnuplot preamble commands, see page 54.
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3.5 Point and Line Types

solid = = ! - - _—

dots ' o

dashss ------ =-=--=--- ==---- ------ ---- ==
e aaltas PR O 0000
shori_long_dashes ————  ———-~- —mme T = -
short_short_long_dashes Bl i = m——

Table 3.1: Examples for 1ine_type and line_width.

0.5 1 1.5
none -1
dot 0
plus 1 ’ t t i i

multiply 2 . x % K ¥ %
asterisk 3 . - 3&: ® ¥ e
square 4 o a 3 8 [4 El
filled_square 5 = B a B2
circle 6 @ o €, g G €
filled_circle 7 . + @ e o —9
up_triangle 8 - O A A\
filled_up_triangle g F A A
down_triangle 10 7 7N 74
filled_down_triangle 11 -——————% ¥-— —y
diamant 12 & & O £
filled_diamant 13 . . —

Table 3.2: Examples for point_type and point_size.
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3.6 Colors

The color values for the options background_color, color, palette and x/y/zaxis_color
can be specified in different ways:

e String with hexadecimal RGB value "#rrggbb". Each digit (byte) represent a hex-
adecimal number 0-9, a-f. Each two bytes represent decimal integers from 0-255.
"#000000" is black and "#ffffff" is white.

e String with hexadecimal RGBA value "#rrggbbtt". The tt bytes denote trans-
parency 00 is opaque (non-transparent) and ff is full transparency. Note that
SMath native plots use the ARGB color scheme ‘“#ttrrggbb’’.

e As color name (string or undefined variable name)

hmrwn uranfa dark arania violet
aquamanne khaki dark_khaki fnrdenmd II?M %Dldenr\ud dark iclld'enrud beige
pink light_pink Ilghl coral umnge red salmun Ilght salmun dark salmon

dark violet plum

skyblue cyan light_t q,ran dark cyan maianta dark rnaianta turquoise  dark Iuﬂqumsa

rwalhlue

medmm blue

5ea_green blue light_blue dﬂrk blue mldnlgh! blue
I - ﬁ
dark_red yellow light_yellow I| ht_green :lark reen  sprin r'crast reen
] lﬁlilﬁﬂﬂ
gray grey light_gray light_ gmy dark_gray dark_grey light_red
- ﬁ
| gray70 | | grey70 | | grays0 | | greys0 graya0 | | grey9a0 | gray100 grey100
i iayd-ﬂ i ii iayﬁﬂ i i iﬁ

Table 3.3: Valid color names. Other colors must be specified as RGB or RGBA hex
strings.
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3.7 Color Mapping (Palette)

Several object can be colored depending on specific values. The quantity to map is
specified using the command enhanced3D, the map from data range to colors is specified
by palette. The option interpolate_color smoothes the color values, which by default
are constant per quadrangle of the sampling grid of functions.

palette colormap

color (default) This is the default color map: black-violet-red-orange-yellow (some-
thing like that)

colorl

color2  custom palette with a given sequence of colors

interpolate_color Sets the interpolation style.
false (default) no interpolation. Each suface patch has a uniform color.
true colors are smoothly interpolated.

The mapping from value to color is visualized using the colorbar. The quantity used for
coloring can be documented by a colorbar title.
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3.8 Contour Lines

In 3D plots, contour lines can be added. They are produced using a marching squares
algorithm working on a regular grid for function sampling.

contour Switch for display of contours:
none (default): don’t display contours.
both display contours on the surface and on the xy-plane
surface display contours on the surface only
base display contours on the xy-plane
map display contours on the xy-plane and set view to 2D. Don’t display the surface.
contour_levels Control the contour levels
n (default n = 5) display n equally spaced contour levels
min
A specify contour levels by minimum value, step A and maximum value
max

set(21,22,...) explicitly list the contour levels

key Title for the contour level legend. If this is not given, no legend is displayed. The
option must be set before the actual plot object.

xu_grid (default: 30) number of sampling points in x direction

yv_grid (default: 30) number of sampling points in y direction
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3.9 Maxima Draw Regions

The Maxima plugin provides dedicated regions for graphics, where the graphics commands
directly go to the placeholder. They are called Draw regions. The advantages of this
approach:

e Mouse control for pan, zoom and rotation of the axes (yet quite slow)

e The size of the generated graphics is adapted to the region size (which you can drag
with the mouse)

e Settings dialog for axes and diagram properties. This reduces the amount of com-
mands required in the input field and of lookup work to find the proper commands.

Insert> Maxima> Draw2D or Draw3D

As long as the input placeholder is empty, a sample plot is shown (left: Draw2D, right:
Draw3D):

SAMPLE PLOT

SAMPLE PLOT

(X,

.

inooon

oo =p

a4l

The placeholder takes a list with draw objects and options just as the first argument of
the functions Draw2D() and Draw3D() (see section (3.2)).

The context menu also has interesting options:
e (Un)select “Display input data” to hide the graphics commands,
e (Un)select the outer border of the region,

e Export graphics to a file. This actually just saves the existing temporary file to a
user-specified location.
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Mouse Control

Sizing: Drag the control points at the border to resize the image. Upon release, the
graphics is re-computed with a new size. If you want to change the font size, use the

settings dialog.

Picture [ wadht / height / berm |
[123 1149 ‘pdr -
i ﬁ i 5 () Spacty (®) Automatic
E i os| | 5.
- -0.5 - Resize the region with the mouse
4 42024 X 4 g
¥
“‘-20
24

i 42 cmd

cmd

Rotating: Drag the image to rotate the plot. Upon release, the graphics is re-computed
with the new orientation.

View [ zenil / anmut | plotscale | z-scale |

| 20 &0 | 1 1
1 1 () Specify  (®)Mouse () Off ()XY
05 L 05 )
. 0 4 0
-0.9 -0.9 .
A -2c| -1 Drag the plot with the mouse
-4 2
203 4
i 432 -4 -2 1] 2 4

Y

cmd cmd

Scaling (axes limits): Scroll (with the mouse wheel): Modifies the axes limits.

Scroll up reduces the limits (expands the objects), scroll down increases the limits (shrinks
the objects). This acts on axes whith range control set to “Mouse” in the Plot settings
form. By default, just the vertical axis is activated.

£-fons
Aois label |2

‘Ftanga Min: -1,20024 Max |1,20024

() Specty (%) Mouse [T
Caod [ Mas [ Logasthne

Scroll

Scaling (bounding box): Shift-scroll changes the size of the bounding box in 3D plots
relative to the region size. Ctrl-scroll scales the bounding box vertically. The axes limits

aren’t affected by these settings.
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hkfyormbs

View [ zenit / azimut / plotscale | 2-scale |

() Specty (@) Mouse  (oOn ()XY

Shift- scroll

\"-lh'fl ZGHII ammul/ pmlsa:alulz m
off f.“;

() Specity  (®) Mouse ()

Ctrl - scroll
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CHAPTER 3. PLOTTING WITH MAXIMA

3.10 Units in Graphics

SMath internally converts any units to base units before storage. Maxima generally treats
units as symbolic constants. In plot functions, any units are replaced by the number 1.

Thus, any base units in plot expressions are optional.

To use a different unit for the independent variables, multiply them by this unit wherever
they appear in the expression.

To use a different units for the value of an expression, divide it by this unit.

£(x)=(x-1m)’

300
= ﬁm -
= ?m -
L a600 =
§ s00 -
| E‘ 400 |
- Em -
- 200 -

- 100

I | \'“"w-._ I _Fr-r’"/ 0 I L i \h"w-__ ! _;-f’f-l
2151050 051 15 2 =200-150-100 =50 0 S50 100 150 200
£mm ¥ Cm

¥ inm

O = k3 W & O o~ 00 D
T

explicit[f(x];x;—E;E] fI:x c:n;'l.

explicit P xX:—200: 200

Cm

Adjust the axes labels accordingly using the xlabel and ylabel options or the settings
menu of the Draw regions.
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4 2D Graphics Objects

Contents
bars . . . ..o 42
boxplot description . . . . . .. ..o 43
ellipse . . . . . L 44
EITOTS .« v v v v e e e e e e e e e e 45
explicit . . . ..o 46
histogram description . . . . . . ..o Lo 47
IMAZE . . v v v v e e e e e e e e e e 48
implicit . . . . . oL 49
implicit . . . . . oL 50
parametric . . .. Lo L L oL Lo e e e e 51
piechart description . . . . . . . ..o 52
points . . . ..o e e e 53
polar . ..o e 54
polygon . . . ..o e 59
quadrilateral . . . . . . oo o o 56
rectangle . . . ... L oL 57
TEZION . . . . . ..o 58
triangle . . .. oL Lo 59
VECTOT . . o L L o 60

=M Draw2dsd-EN.sm (takes some time to recalculate)

Here we demonstrate the available objects for 2D graphics, i.e. for use with Draw2D() or
the Draw2D region. For some of the objects, we also explain some of the most important
options. The Draw Description snippet is a good source on available options.
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       decimal
    
     
       
       
       &[DATE] &[TIME] - &[FILENAME]
       &[PAGENUM] / &[COUNT]
       
    
     
       
       
       
       
       
       
       
       
       
       
       
       
    
  
   
     
       
         
           restart
           MaximaControl
        
         
           Restart complete.
        
      
    
     
       
         
           
             Draw-Descriptions (Maxima)
          
        
         
           
             Draw-Descriptions (Maxima)
          
        
      
       
         
           
           Optionen 
        
        
         
           
           Options
        
        
      
       
         
           
             
             [Maxima Draw] adapt_depth (=10): maximale Teilungstiefe der adaptive Kurvenabtastung
          
          
           
             
             [Maxima Draw] adapt_depth (=10) maximum number of adaptive interval splits when drawing curves
          
          
           
             adapt_depth
             adapt_depth
             :
          
        
      
       
         
           
             
             [Maxima Draw] axis_3d (=true): Achsen im 3D zeichnen, false: keine Achsen zeichnen
          
          
           
             
             [Maxima Draw] axis_3d (=true): draw 3D axes, false: don't draw axes
          
          
           
             axis_3d
             axis_3d
             :
          
        
      
       
         
           
             
             [Maxima Draw]  axis_bottom (=true): untere Achse im 2D zeichnen, false: Achse nicht zeichnen
          
          
           
             
             [Maxima Draw]  axis_bottom (=true): draw bottom axis in 2D, false: don't draw axis
          
          
           
             axis_bottom
             axis_bottom
             :
          
        
      
       
         
           
             
             [Maxima Draw] axis_top (=true): obere Achse im 2D zeichnen, false: Achse nicht zeichnen
          
          
           
             
             [Maxima Draw] axis_top (=true): draw top axis in 2D, false: don't draw axis
          
          
           
             axis_top
             axis_top
             :
          
        
      
       
         
           
             
             [Maxima Draw] axis_left (=true): linke Achse im 2D zeichnen, false: Achse nicht zeichnen
          
          
           
             
             [Maxima Draw] axis_left (=true): draw left axis in 2D, false: don't draw axis
          
          
           
             axis_left
             axis_left
             :
          
        
      
       
         
           
             
             [Maxima Draw] axis_right (=true): rechte Achse im 2D zeichnen, false: Achse nicht zeichnen
          
          
           
             
             [Maxima Draw] axis_right (=true): draw right axis in 2D, false: don't draw axis
          
          
           
             axis_right
             axis_right
             :
          
        
      
       
         
           
             
             [Maxima Draw] background_color (=white): Hintergrundfarbe des Diagramms
          
          
           
             
             [Maxima Draw] background_color (=white): background color of the plot
          
          
           
             background_color
             background_color
             :
          
        
      
       
         
           
             
             [Maxima Draw] border (=true): Ränder von polygon(), ellipse() oder rectangle() zeichnen
          
          
           
             
             [Maxima Draw] border (=true): draw borders of polygon(), ellipse() or rectangle() objects
          
          
           
             border
             border
             :
          
        
      
       
         
           
             
             [Maxima Draw] capping(=false): Endflächen an tube()-Objekten, false, true oder Liste mit zwei Werten.
          
          
           
             
             [Maxima Draw] capping (=false): indicates if extremes of the tube object remain open (false) or  are closed (true). If only one end is to be closed, provide a list with two entries.
          
          
           
             capping
             capping
             :
          
        
      
       
         
           
             
             [Maxima Draw] cbrange (=auto): Farbbereich (Liste min,max)
          
          
           
             
             [Maxima Draw] cbrange (=auto): color bar range (list min,max)
          
          
           
             cbrange
             cbrange
             :
          
        
      
       
         
           
             
             [Maxima Draw] cbtics (=auto): Marken an der Farblegende
          
          
           
             
             [Maxima Draw] cbtics (=auto): color bar tick marks
          
          
           
             cbtics
             cbtics
             :
          
        
      
       
         
           
             
             [Maxima Draw] color (=blue): Farbe für Linien, Punkte, Kanten und Text, als Namen oder hexadezimal in der Form  "#rrggbb"
          
          
           
             
             [Maxima Draw] color (=blue): color for lines, points, borders and text, given as name or as "#rrggbb"
          
          
           
             color
             color
             :
          
        
      
       
         
           
             
             [Maxima Draw] colorbox (=true): Farblegende ohne Beschriftung zeichnen, false: keine Farblegende  zeichnen, text: Farblegende mit text als Beschriftung zeichnen.
          
          
           
             
             [Maxima Draw] colorbox (=true): draw color scale without label, false: no colorbar,  string: draw colorbar with string as label.
          
          
           
             colorbox
             colorbox
             :
          
        
      
       
         
           
             
             [Maxima Draw] contour (=none): Art der Höhenlinien. none: keine, base: auf der xy-Ebene, surface: auf der 3D-Fläche, both: auf xy-Ebene und Fläche, map: auf xy-Ebene und Blickrichtung senkrecht.
          
          
           
             
             [Maxima Draw] contour (=none): contour lines. none: no contours, base: on xy plane,  surface: on 3D surface, both: on xy plane and surface, map: on xy plane plus vertical view.
          
          
           
             contour
             contour
             :
          
        
      
       
         
           
             
             [Maxima Draw]  contour_levels (=5): Werte für die Höhenlinien. Anzahl oder Liste  (min, Δ, max), oder set(L1, L2,...) mit Werten
          
          
           
             
             [Maxima Draw]  contour_levels (=5): contour levels. number oder list  (min, Δ, max), or set(L1, L2,...) of values
          
          
           
             contour_levels
             contour_levels
             :
          
        
      
       
         
           
             
             [Maxima Draw]  data_file_name (="data.gnuplot"): Kurvendaten für Gnuplot
          
          
           
             
             [Maxima Draw]  data_file_name (="data.gnuplot"): internal data file name for gnuplot
          
          
           
             data_file_name
             data_file_name
             :
          
        
      
       
         
           
             
             [Maxima Draw]  delay (=5) Zeitschritt in animierten gif-Dateien
          
          
           
             
             [Maxima Draw]  delay (=5): time step in animated gif files
          
          
           
             delay
             delay
             :
          
        
      
       
         
           
             
             [Maxima Draw]  dimensions (= 600 x 500): Liste [Breite,Höhe]
          
          
           
             
             [Maxima Draw]  dimensions (= 300 x 240 for 2D, 300 x 300 for 3D) list [width, height]
          
          
           
             dimensions
             dimensions
             :
          
        
      
       
         
           
             
             [Maxima Draw]  draw_realpart (=true) Realteil zur Darstellung komplexer Werte verwenden
          
          
           
             
             [Maxima Draw]  draw_realpart (=true) use real part for plotting complex values
          
          
           
             draw_realpart
             draw_realpart
             :
          
        
      
       
         
           
             
             [Maxima Draw]  enhanced3d (=true) Farbpalette, none: 3D Flächen als Gitter zeichnen   (Steuerung mit color und surface_hide), true: Farbe anhand des z-Werts,  Liste  [f(x,y,z), x, y, z]: Farbe anhand der Funktion f,   Liste [f(u,v),u,v]: Farbe anhand der Flächenparameter oder Liste [f(k), k ]:  Farbe anhand der Punktnummer in points() Objekten
          
          
           
             
             [Maxima Draw]  enhanced3d (=true) don't use color palette, draw 3D surfaces as grid  (control using color und surface_hide), true: coloring of surfaces by z-value,  or  list  [f(x,y,z), x, y, z]: coloring according to function f or  list [f(u,v),u,v]  or list [f(k), k ] (k being the point counter in points() objects)
          
          
           
             enhanced3d
             enhanced3d
             :
          
        
      
       
         
           
             
             [Maxima Draw] error_type (=y) Art der Fehlerbalken in errors():  x, y, xy oder boxes
          
          
           
             
             [Maxima Draw] error_type (=y) type of error bars in errors():  x, y, xy or boxes
          
          
           
             error_type
             error_type
             :
          
        
      
       
         
           
             
             [Maxima Draw] file_name (="maxima_out") Grafik-Ausgabedatei, Endung wird gemäß Ausgabeformat ergänzt
          
          
           
             
             [Maxima Draw] file_name (="maxima_out") output file, extension is set according to format
          
          
           
             file_name
             file_name
             :
          
        
      
       
         
           
             
             [Maxima Draw] fill_color (=red) Füllfarbe für Objejte polygon() und  explicit() in 2D 
          
          
           
             
             [Maxima Draw] fill_color (=red) fill color for polygons and explicit functions y(x) in 2D 
          
          
           
             fill_color
             fill_color
             :
          
        
      
       
         
           
             
             [Maxima Draw] fill_density (=0) Deckungsgrad der Füllfarbe in bars()-Objekten, zwischen 0 und 1
          
          
           
             
             [Maxima Draw] fill_density (=0) opacity of the fill color in bars()-objects, 0..1
          
          
           
             fill_density
             fill_density
             :
          
        
      
       
         
           
             
             [Maxima Draw] filled_func (=false): explizite Funktionen y(x) werden nicht gefüllt, true: Füllung bis zur Unterkante des Diagramms, g(x): Füllung zwischen g(x)  und y(x)
          
          
           
             
             [Maxima Draw] filled_func (=false): don't fill explicit functions y(x), true: fill between the next explicit() object and the bottom border of the diagram, g(x): fill between g(x) and the next explicit() object
          
          
           
             filled_func
             filled_func
             :
          
        
      
       
         
           
             
             [Maxima Draw] gnuplot_file_name (="maxout.gnuplot"): Kommandodatei für Gnuplot
          
          
           
             
             [Maxima Draw] gnuplot_file_name (="maxout.gnuplot"): name of the temporary gnuplot command file
          
          
           
             gnuplot_file_name
             gnuplot_file_name
             :
          
        
      
       
         
           
             
             [Maxima Draw] gnuplot_term (): Ausgabe-Format-Spezifikation (Text nach "set terminal")
          
          
           
             
             [Maxima Draw] gnuplot_term (): gnuplot terminal options (arguments of "set terminal")
          
          
           
             gnuplot_term
             gnuplot_term
             :
          
        
      
       
         
           
             
             [Maxima Draw] gnuplot_out_file (=maxplot.xxx) Ausgabedateiname (xxx abhängig vom Format)
          
          
           
             
             [Maxima Draw] gnuplot_out_file (=maxplot.xxx) output file name (xxx depends on terminal)
          
          
           
             gnuplot_out_file
             gnuplot_out_file
             :
          
        
      
       
         
           
             
             [Maxima Draw] grid (=true): false: kein Gitterraster zeichnen, true: Gitter zeichnen
          
          
           
             
             [Maxima Draw] grid (=true): draw grid, remove grid by user_preamble="unset grid"
          
          
           
             grid
             grid
             :
          
        
      
       
         
           
             
             [Maxima Draw] head_angle (=45) Pfeilwinkel an vector()-Objekten (halber Öffnungswinkel in °)
          
          
           
             
             [Maxima Draw] head_angle (=45): head angle of vector()-Objekten (angle between border and vector   direction in °)
          
          
           
             head_angle
             head_angle
             :
          
        
      
       
         
           
             
             [Maxima Draw] head_both (=false) oder true: ob bei vector()-Objekten zwei Pfeilspitzen gezeichnet werden.
          
          
           
             
             [Maxima Draw] head_both (=false): don't draw a second head of vector() objects,  true: draw a second head
          
          
           
             head_both
             head_both
             :
          
        
      
       
         
           
             
             [Maxima Draw] head_length (=2) Länge der Pfeilspitze  bei vector()-Objekten in Einheiten der x-Achse
          
          
           
             
             [Maxima Draw] head_length (=2): head length of vector() objects in units of the x-axis
          
          
           
             head_length
             head_length
             :
          
        
      
       
         
           
             
             [Maxima Draw] head_type (=filled) Spitzenform bei vector()-Objekten:  filled, empty  oder nonfilled
          
          
           
             
             [Maxima Draw] head_type (=filled) head type of vector() objects:  filled, empty  or nonfilled
          
          
           
             head_type
             head_type
             :
          
        
      
       
         
           
             
             [Maxima Draw] ip_grid (={50, 50): Primäres Gitter für die Darstellung impliziter Funktionen, als Liste angeben
          
          
           
             
             [Maxima Draw] ip_grid (={50, 50): primary grid for sampling of implicit functions, two-element list
          
          
           
             ip_grid
             ip_grid
             :
          
        
      
       
         
           
             
             [Maxima Draw] ip_grid_in (={5, 5 ): Sekundäres Gitter für die Darstellung impliziter Funktionen
          
          
           
             
             [Maxima Draw] ip_grid_in (={5, 5 ): secondary grid for sampling of implicit functions
          
          
           
             ip_grid_in
             ip_grid_in
             :
          
        
      
       
         
           
             
             [Maxima Draw] key (=""): Legendeneintrag für das nachfolgende Grafikobjekt.
          
          
           
             
             [Maxima Draw] key (=""): legend key for subsequent graphics object.
          
          
           
             key
             key
             :
          
        
      
       
         
           
             
             [Maxima Draw] key_pos (="", entspricht top_right): Legendenposition. Gültige Werte: top_left, top_center, top_right,  center_left, center, center_right, bottom_left, bottom_center, bottom_right
          
          
           
             
             [Maxima Draw] key_pos (="", equivalent to top_right): position of the legend. Valid options: top_left, top_center, top_right,  center_left, center, center_right, bottom_left, bottom_center, bottom_right
          
          
           
             key_pos
             key_pos
             :
          
        
      
       
         
           
             
             [Maxima Draw] label_alignment (=center), left oder right: horizontale Ausrichtung von Beschriftungen
          
          
           
             
             [Maxima Draw] label_alignment (=center), left or right: alignment of text labels
          
          
           
             label_alignment
             label_alignment
             :
          
        
      
       
         
           
             
             [Maxima Draw] label_orientation (=horizontal) oder vertical: Ausrichtung von Texten
          
          
           
             
             [Maxima Draw] label_orientation (=horizontal) or vertical: orientation of text labels
          
          
           
             label_orientation
             label_orientation
             :
          
        
      
       
         
           
             
             [Maxima Draw] line_type (=solid) Linienart. Alternativen: dots (für alle Formate) oder wenn von Gnuplot unterstützt: dashes, short_dashes, short_long_dashes, short_short_long_dashes 
          
          
           
             
             [Maxima Draw] line_type (=solid) line type. Other options: dots (for all formats) or if supported by Gnuplot: dashes, short_dashes, short_long_dashes, short_short_long_dashes 
          
          
           
             line_type
             line_type
             :
          
        
      
       
         
           
             
             [Maxima Draw] line_width (=1) , >0 
          
          
           
             line_width
             line_width
             :
          
        
      
       
         
           
             
             [Maxima Draw] logcb (=false) oder true: logarithmische Farbskale
          
          
           
             
             [Maxima Draw] logcb (=false) or true: log scale of the colorbar
          
          
           
             logcb
             logcb
             :
          
        
      
       
         
           
             
             [Maxima Draw] logx (=false) oder true: logarithmische x-Achse
          
          
           
             
             [Maxima Draw] logx (=false) or true: log scale of x-axis
          
          
           
             logx
             logx
             :
          
        
      
       
         
           
             
             [Maxima Draw] logx_secondary (=false) oder true: logarithmische zweite x-Achse
          
          
           
             
             [Maxima Draw] logx_secondary (=false) or true: log scale of secondary x-axis
          
          
           
             logx_secondary
             logx_secondary
             :
          
        
      
       
         
           
             
             [Maxima Draw] logy (=false) oder true: logarithmische y-Achse
          
          
           
             
             [Maxima Draw] logy (=false) or true: log scale of y-axis
          
          
           
             logy
             logy
             :
          
        
      
       
         
           
             
             [Maxima Draw] logy_secondary (=false) oder true: logarithmische zweite y-Achse
          
          
           
             
             [Maxima Draw] logy_secondary (=false) or true: log scale of secondary y-axis
          
          
           
             logy_secondary
             logy_secondary
             :
          
        
      
       
         
           
             
             [Maxima Draw] logz (=false) oder true: logarithmische z-Achse
          
          
           
             
             [Maxima Draw] logz (=false) or true: log scale of z-axis
          
          
           
             logz
             logz
             :
          
        
      
       
         
           
             
             [Maxima Draw] nticks (=29): Punktezahl für die Kurvenabtastung
          
          
           
             
             [Maxima Draw] nticks (=29): number of points for curve sampling (explicit and parametric)
          
          
           
             nticks
             nticks
             :
          
        
      
       
         
           
             
             [Maxima Draw] palette (=[violet, blue, green, yellow, re]) color: Standard-Farbpalette, gray: Graustufen, Liste [ Farbe1, Farbe2... ] oder false: Flächen nicht färben 
          
          
           
             
             [Maxima Draw] palette (=[violet, blue, green, yellow, red]) color palette, color: standard color palette (black, violet, red, yellow), gray: gray levels, list  [color1, color2... ] or false: don't color 3D objects 
          
          
           
             palette
             palette
             :
          
        
      
       
         
           
             
             [Maxima Draw] point_size (=1) Größe von points()-Symbolen
          
          
           
             
             [Maxima Draw] point_size (=1) size of points()-symbols
          
          
           
             point_size
             point_size
             :
          
        
      
       
         
           
             
             [Maxima Draw] point_type (=1) Symbol für points()-Objekte, Name oder Kennzahl:  none -1, dot 0, plus 1, multiply 2, asterisk 3, square 4, filled_square 5,  circle 6, filled_circle 7, up_triangle 8, filled_up_triangle 9, down_triangle 10,  filled_dwn_triangle 11, diamant 12, filled_diamant 13
          
          
           
             
             [Maxima Draw] point_type (=1) type of points() objects, name or key number: none -1, dot 0, plus 1, multiply 2, asterisk 3, square 4, filled_square 5,  circle 6, filled_circle 7, up_triangle 8, filled_up_triangle 9, down_triangle 10,  filled_down_triangle 11, diamant 12, filled_diamant 13
          
          
           
             point_type
             point_type
             :
          
        
      
       
         
           
             
             [Maxima Draw] points_joined (=false), true oder impulses: Verbindungsart von points()-Objekten
          
          
           
             
             [Maxima Draw] points_joined (=false), true or impulses: how to join points
          
          
           
             points_joined
             points_joined
             :
          
        
      
       
         
           
             
             [Maxima Draw] proportional_axes (=none), xy oder xyz: Achsen mit gleicher Skalierung)
          
          
           
             
             [Maxima Draw] proportional_axes (=none), xy or xyz: set axes of equal scaling)
          
          
           
             proportional_axes
             proportional_axes
             :
          
        
      
       
         
           
             
             [Maxima Draw] surface_hide (=false) oder true: Ausblendung verdeckter Flächen bei Linienrasterdarstellung
          
          
           
             
             [Maxima Draw] surface_hide (=false) or true: handling of hidden lines in surface grids
          
          
           
             surface_hide
             surface_hide
             :
          
        
      
       
         
           
             
             [Maxima Draw] terminal (=screen) separate interactive terminal window,  png, jpg, gif, eps, svg, pdf,  animated_gif: gnuplot output format
          
          
           
             terminal
             terminal
             :
          
        
      
       
         
           
             
             [Maxima Draw] title (="") Überschrift für das Diagramm
          
          
           
             
             [Maxima Draw] title (="") headline for the plot
          
          
           
             title
             title
             :
          
        
      
       
         
           
             
             [Maxima Draw] transform (=none) Koordinatentransformation, für 2D als Liste {f1(x,y), f2(x,y), x, y, für 3D als Liste {f1(x,y), f2(x,y), f3(x, y, z), x, y, z
          
          
           
             
             [Maxima Draw] transform (=none) co-ordinate transformation, for 2D as list {f1(x,y), f2(x,y), x, y, for 3D as list {f1(x,y), f2(x,y), f3(x, y, z), x, y, z
          
          
           
             transform
             transform
             :
          
        
      
       
         
           
             
             [Maxima Draw] transparent (=false) oder true: ob Rechtecke, Polygone oder Ellipsen transparent sein sollen  (bei false werden sie gefüllt)
          
          
           
             
             [Maxima Draw] transparent (=false) fill objects with border, true: don't fill (make them transparent)
          
          
           
             transparent
             transparent
             :
          
        
      
       
         
           
             
             [Maxima Draw] unit_vectors (=false) oder true: Vektoren in originaler Länge oder als Einheitsvektoren zeichnen.
          
          
           
             
             [Maxima Draw] unit_vectors (=false) draw vectors in original length, true: draw unit vectors.
          
          
           
             unit_vectors
             unit_vectors
             :
          
        
      
       
         
           
             
             [Maxima Draw] user_preamble (="") Zeichenkette oder Liste von Zeichenketten, die unmittelbar vor dem eigentlichen  Diagrammbefehl an Gnuplot übergeben werden.
          
          
           
             
             [Maxima Draw] user_preamble (="") string or list of strings, gnuplot commands placed  immediately before the plot commands
          
          
           
             user_preamble
             user_preamble
             :
          
        
      
       
         
           
             
             [Maxima Draw] view (=(60,30)) view direction
          
          
           
             view
             view
             :
          
        
      
       
         
           
             
             [Maxima Draw] wired_surface (=false) oder true: Gitternetz auf eingefärbten Flächen anzeigen oder nicht.
          
          
           
             
             [Maxima Draw] wired_surface (=false) no grid on colored surfaces, true: draw grid on surfaces
          
          
           
             wired_surface
             wired_surface
             :
          
        
      
       
         
           
             
             [Maxima Draw] x_voxel (=10) x-Bereichsteilung für den  Marching-Cubes-Algorithmus bei implizit gegebenen Flächen
          
          
           
             
             [Maxima Draw] x_voxel (=10) number of x steps for the Marching Cube algorithm (for implicit 3D functions)
          
          
           
             x_voxel
             x_voxel
             :
          
        
      
       
         
           
             
             [Maxima Draw] y_voxel (=10) y-Bereichsteilung für den  Marching-Cubes-Algorithmus bei implizit gegebenen Flächen
          
          
           
             
             [Maxima Draw] y_voxel (=10) number of y steps for the Marching Cube algorithm (for implicit 3D functions)
          
          
           
             y_voxel
             y_voxel
             :
          
        
      
       
         
           
             
             [Maxima Draw] z_voxel (=10) z-Bereichsteilung für den  Marching-Cubes-Algorithmus bei implizit gegebenen Flächen
          
          
           
             
             [Maxima Draw] z_voxel (=10) number of z steps for the Marching Cube algorithm (for implicit 3D functions)
          
          
           
             z_voxel
             z_voxel
             :
          
        
      
       
         
           
             
             [Maxima Draw] xaxis (=true) oder false: Anzeige der x-Achse
          
          
           
             
             [Maxima Draw] xaxis (=true) false: don't draw x-axis or true: draw x-axis
          
          
           
             xaxis
             xaxis
             :
          
        
      
       
         
           
             
             [Maxima Draw] yaxis (=true) oder false: Anzeige der y-Achse
          
          
           
             
             [Maxima Draw] yaxis (=true) false: don't draw x-axis or true: draw y-axis
          
          
           
             yaxis
             yaxis
             :
          
        
      
       
         
           
             
             [Maxima Draw] zaxis (=true) oder false: Anzeige der z-Achse
          
          
           
             
             [Maxima Draw] zaxis (=false) or true: draw z-axis
          
          
           
             zaxis
             zaxis
             :
          
        
      
       
         
           
             
             [Maxima Draw] xaxis_color (=black) Farbe x-Achse
          
          
           
             
             [Maxima Draw] xaxis_color (=black) color of the x-axis
          
          
           
             xaxis_color
             xaxis_color
             :
          
        
      
       
         
           
             
             [Maxima Draw] yaxis_color (=black) Farbe y-Achse
          
          
           
             
             [Maxima Draw] yaxis_color (=black) color of the y-axis
          
          
           
             yaxis_color
             yaxis_color
             :
          
        
      
       
         
           
             
             [Maxima Draw] zaxis_color (=black) Farbe z-Achse
          
          
           
             
             [Maxima Draw] zaxis_color (=black) color of the z-axis
          
          
           
             zaxis_color
             zaxis_color
             :
          
        
      
       
         
           
             
             [Maxima Draw] xaxis_secondary (=false) oder true: Nutzung einer zweiten x-Achse (oben) für die nachfolgenden Objekte
          
          
           
             
             [Maxima Draw] xaxis_secondary (=false) or true: use the secondary x-axis (top) for subsequent objects
          
          
           
             xaxis_secondary
             xaxis_secondary
             :
          
        
      
       
         
           
             
             [Maxima Draw] yaxis_secondary (=false) oder true: Nutzung einer zweiten y-Achse (rechts) für die nachfolgenden Objekte
          
          
           
             
             [Maxima Draw] yaxis_secondary (=false) or true: use the secondary y-axis (right) for subsequent objects
          
          
           
             yaxis_secondary
             yaxis_secondary
             :
          
        
      
       
         
           
             
             [Maxima Draw] xaxis_type (=solid) oder dots: Linienart der x-Achse
          
          
           
             
             [Maxima Draw] xaxis_type (=solid) or dots
          
          
           
             xaxis_type
             xaxis_type
             :
          
        
      
       
         
           
             
             [Maxima Draw] yaxis_type (=solid) oder dots: Linienart der y-Achse
          
          
           
             
             [Maxima Draw] yaxis_type (=solid) or dots
          
          
           
             yaxis_type
             yaxis_type
             :
          
        
      
       
         
           
             
             [Maxima Draw] zaxis_type (=dots) oder solid: Linienart der z-Achse
          
          
           
             
             [Maxima Draw] zaxis_type (=dots) or solid
          
          
           
             zaxis_type
             zaxis_type
             :
          
        
      
       
         
           
             
             [Maxima Draw] xaxis_width (=1) Linienbreite der x-Achse
          
          
           
             
             [Maxima Draw] xaxis_width (=1)
          
          
           
             xaxis_width
             xaxis_width
             :
          
        
      
       
         
           
             
             [Maxima Draw] yaxis_width (=1) Linienbreite der y-Achse
          
          
           
             
             [Maxima Draw] yaxis_width (=1)
          
          
           
             yaxis_width
             yaxis_width
             :
          
        
      
       
         
           
             
             [Maxima Draw] zaxis_width (=1) Linienbreite der z-Achse
          
          
           
             
             [Maxima Draw] zaxis_width (=1)
          
          
           
             zaxis_width
             zaxis_width
             :
          
        
      
       
         
           
             
             [Maxima Draw] xlabel (="") x-Achsenbeschriftung
          
          
           
             
             [Maxima Draw] xlabel (="x") label of the x-axis, remove using ""
          
          
           
             xlabel
             xlabel
             :
          
        
      
       
         
           
             
             [Maxima Draw] ylabel(="") y-Achsenbeschriftung
          
          
           
             
             [Maxima Draw] ylabel (="y") label of the y-axis, remove using ""
          
          
           
             ylabel
             ylabel
             :
          
        
      
       
         
           
             
             [Maxima Draw] zlabel (="") z-Achsenbeschriftung
          
          
           
             
             [Maxima Draw] zlabel (="") label of the z-axis
          
          
           
             zlabel
             zlabel
             :
          
        
      
       
         
           
             
             [Maxima Draw] xlabel_secondary (="") Beschriftung der zweiten x-Achse
          
          
           
             
             [Maxima Draw] xlabel_secondary (="") label of the secondary x-axis
          
          
           
             xlabel_secondary
             xlabel_secondary
             :
          
        
      
       
         
           
             
             [Maxima Draw] ylabel_secondary (="") Beschriftung der zweiten y-Achse
          
          
           
             
             [Maxima Draw] ylabel_secondary (="") label of the secondary y-axis
          
          
           
             ylabel_secondary
             ylabel_secondary
             :
          
        
      
       
         
           
             
             [Maxima Draw] xrange (=auto) oder Liste {min,max: x-Achsenbereich
          
          
           
             
             [Maxima Draw] xrange (=auto) or list {min,max: range of the x-axis
          
          
           
             xrange
             xrange
             :
          
        
      
       
         
           
             
             [Maxima Draw] yrange (=auto) oder Liste {min,max: y-Achsenbereich
          
          
           
             
             [Maxima Draw] yrange (=auto) or list {min,max: range of the y-axis
          
          
           
             yrange
             yrange
             :
          
        
      
       
         
           
             
             [Maxima Draw] zrange (=auto) oder Liste {min,max: z-Achsenbereich
          
          
           
             
             [Maxima Draw] zrange (=auto) or list {min,max: range of the z-axis
          
          
           
             zrange
             zrange
             :
          
        
      
       
         
           
             
             [Maxima Draw] xrange_secondary (=auto) oder Liste {min,max: Bereich der zweiten (oberen) x-Achse
          
          
           
             
             [Maxima Draw] xrange_secondary (=auto) or list {min,max: range of the secondary (top) x-axis
          
          
           
             xrange_secondary
             xrange_secondary
             :
          
        
      
       
         
           
             
             [Maxima Draw] yrange_secondary (=auto) oder Liste {min,max: Bereich der zweiten (rechten) y-Achse
          
          
           
             
             [Maxima Draw] yrange_secondary (=auto) or list {min,max: range of the secondary (right) y-axis
          
          
           
             yrange_secondary
             yrange_secondary
             :
          
        
      
       
         
           
             
             [Maxima Draw] xtics (=auto): automatische x-Achsmarken, none: keine, Zahl: Schrittweite,  Liste mit {min, Schritt, max, oder set() von Zahlen: explizite Vorgabe der Zahlenwerte, oder set()  von Listen ("text",pos) mit Vorgabe von Beschriftung und Position.
          
          
           
             
             [Maxima Draw] xtics (=auto): automatic x ticks, none: no x ticks, number: tick interval,   list of {min, step, max, or set() of numbers: explicit tick values, or set() of lists ("text",pos) for spec of position and text.
          
          
           
             xtics
             xtics
             :
          
        
      
       
         
           
             
             [Maxima Draw] ytics (=auto): automatische y-Achsmarken, none: keine, Zahl: Schrittweite,  Liste mit {min, Schritt, max, oder set() von Zahlen: explizite Vorgabe der Zahlenwerte, oder set()  von Listen {"text",pos mit Vorgabe von Beschriftung und Position.
          
          
           
             
             [Maxima Draw] ytics (=auto): automatic y ticks, none: no y ticks, number: tick interval,   list of {min, step, max, or set() of numbers: explicit tick values, or set() of lists ("text",pos) for spec of position and text.
          
          
           
             ytics
             ytics
             :
          
        
      
       
         
           
             
             [Maxima Draw] ztics (=auto): automatische z-Achsmarken, none: keine, Zahl: Schrittweite,  Liste mit {min, Schritt, max, oder set() von Zahlen: explizite Vorgabe der Zahlenwerte, oder set()  von Listen {"text",pos mit Vorgabe von Beschriftung und Position.
          
          
           
             
             [Maxima Draw] ztics (=auto): automatic z ticks, none: no x ticks, number: tick interval,   list of {min, step, max, or set() of numbers: explicit tick values, or set() of lists ("text",pos) for spec of position and text.
          
          
           
             ztics
             ztics
             :
          
        
      
       
         
           
             
             [Maxima Draw] xtics_secondary (=auto): automatische Marken an der sekundären (oberen) x-Achse, none: keine,  Zahl: Schrittweite,  Liste mit {min, Schritt, max, oder set() von Zahlen: explizite Vorgabe der Zahlenwerte, oder set()  von Listen {"text",pos mit Vorgabe von Beschriftung und Position.
          
          
           
             
             [Maxima Draw] xtics_secondary (=auto): automatic ticks on the secondary (top) x-axis, none: no ticks, number: tick interval,   list of {min, step, max, or set() of numbers: explicit tick values, or set() of lists ("text",pos) for spec of position and text.
          
          
           
             xtics_secondary
             xtics_secondary
             :
          
        
      
       
         
           
             
             [Maxima Draw] ytics_secondary (=auto): automatische Marken an der sekundären (rechten) y-Achse, none: keine,  Zahl: Schrittweite,  Liste mit {min, Schritt, max, oder set() von Zahlen: explizite Vorgabe der Zahlenwerte, oder set()  von Listen {"text",pos mit Vorgabe von Beschriftung und Position.
          
          
           
             
             [Maxima Draw] ytics_secondary (=auto): automatic ticks on the secondary (right) y-axis, none: no ticks, number: tick interval,   list of {min, step, max, or set() of numbers: explicit tick values, or set() of lists ("text",pos) for spec of position and text.
          
          
           
             ytics_secondary
             ytics_secondary
             :
          
        
      
       
         
           
             
             [Maxima Draw] xtics_axis (=false): x-Achsmarken am Rand, true: an der Achse
          
          
           
             
             [Maxima Draw] xtics_axis (=false): ticks on the boundary, true: ticks on the axis
          
          
           
             xtics_axis
             xtics_axis
             :
          
        
      
       
         
           
             
             [Maxima Draw] ytics_axis (=false): y-Achsmarken am Rand, true: an der Achse
          
          
           
             
             [Maxima Draw] ytics_axis (=false): ticks on the boundary, true: ticks on the axis
          
          
           
             ytics_axis
             ytics_axis
             :
          
        
      
       
         
           
             
             [Maxima Draw] ztics_axis (=false): z-Achsmarken am Rand, true: an der Achse
          
          
           
             
             [Maxima Draw] ztics_axis (=false): ticks on the boundary, true: ticks on the axis
          
          
           
             ztics_axis
             ztics_axis
             :
          
        
      
       
         
           
             
             [Maxima Draw] xtics_secondary_axis (=false): Marken an der sekundaren (oberen) x-Achse am Rand, true: an der Achse
          
          
           
             
             [Maxima Draw] xtics_secondary_axis (=false): ticks on the secondary (top) boundary, true: ticks on the axis
          
          
           
             xtics_secondary_axis
             xtics_secondary_axis
             :
          
        
      
       
         
           
             
             [Maxima Draw] ytics_secondary_axis (=false): Marken an der sekundaren (rechten) y-Achse am Rand, true: an der Achse
          
          
           
             
             [Maxima Draw] ytics_secondary_axis (=false): ticks on the secondary (right) boundary, true: ticks on the axis
          
          
           
             ytics_secondary_axis
             ytics_secondary_axis
             :
          
        
      
       
         
           
             
             [Maxima Draw] xtics_rotate (=false): x-Achsmarken nicht drehen, true: um 90° drehen
          
          
           
             
             [Maxima Draw] xtics_rotate (=false): horizontal tick labels, true: vertical tick labels
          
          
           
             xtics_rotate
             xtics_rotate
             :
          
        
      
       
         
           
             
             [Maxima Draw] ytics_rotate (=false): y-Achsmarken nicht drehen, true: um 90° drehen
          
          
           
             
             [Maxima Draw] ytics_rotate (=false): horizontal tick labels, true: vertical tick labels
          
          
           
             ytics_rotate
             ytics_rotate
             :
          
        
      
       
         
           
             
             [Maxima Draw] ztics_rotate (=false): z-Achsmarken nicht drehen, true: um 90° drehen
          
          
           
             
             [Maxima Draw] ztics_rotate (=false): horizontal tick labels, true: vertical tick labels
          
          
           
             ztics_rotate
             ztics_rotate
             :
          
        
      
       
         
           
             
             [Maxima Draw] xtics_rotate_secondary (=false): Marken an der sekundären (oberen) x-Achse nicht drehen, true: um 90° drehen
          
          
           
             
             [Maxima Draw] xtics_rotate_secondary (=false): don't rotate ticks of the secondary (top) x-axis, true: rotate about 90°
          
          
           
             xtics_rotate_secondary
             xtics_rotate_secondary
             :
          
        
      
       
         
           
             
             [Maxima Draw] ytics_rotate_secondary (=false): Marken an der sekundären (rechten) y-Achse nicht drehen, true: um 90° drehen
          
          
           
             
             [Maxima Draw] ytics_rotate_secondary (=false): don't rotate ticks of the secondary (right) y-axis, true: rotate about 90°
          
          
           
             ytics_rotate_secondary
             ytics_rotate_secondary
             :
          
        
      
       
         
           
             
             [Maxima Draw] xu_grid (=30) Abtastpunkte in x- oder u-Richtung 
          
          
           
             
             [Maxima Draw] xu_grid (=30) sampling points in x- or u-direction 
          
          
           
             xu_grid
             xu_grid
             :
          
        
      
       
         
           
             
             [Maxima Draw] yv_grid (=30) Abtastpunkte in y- oder v-Richtung 
          
          
           
             
             [Maxima Draw] yv_grid (=30) sampling points in y- or v-direction 
          
          
           
             yv_grid
             yv_grid
             :
          
        
      
       
         
           
             
             [Maxima Draw]  xyplane (=false):  xy-Koordinatenebene automatisch anordnen, Zahl: z-Koordinate
          
          
           
             
             [Maxima Draw3D]  xyplane (=false):  automatic allocation of the xy-plane, reak number: xy-plane intersects the z-axis at this level
          
          
           
             xyplane
             xyplane
             :
          
        
      
       
         
           
           Objekte 
        
        
      
       
         
           
             
             [Maxima Draw2D] bars(b1,b2...) Säulendiagramm, Säulen gegeben durch Listen (x,h,w). Optionen: key, color, fill_color, fill_density and line_
          
          
           
             
             [Maxima Draw2D] bars(b1,b2...) vertical bars, given as lists (x,h,w). Options: key, color, fill_color, fill_density and line_width
          
          
           
             _
             bars
             _
             bars
             :
          
        
      
       
         
           
             
             [Maxima Draw3D] elevation_grid(Matrix,x0,y0,w,h) Stellt eine Matrix in 3D dar. M_11 bei x=x0,y=y0+h, M_mn bei x=x0+w,y=y0. Optionem:  xu_grid, yv_grid, line_type, key, wired_surface, enhanced3d and color
          
          
           
             
             [Maxima Draw3D] elevation_grid(Matrix,x0,y0,w,h) Draws a m x n-matrix in 3D. M_11 at x=x0,y=y0+h, M_mn at x=x0+w,y=y0. Options:  xu_grid, yv_grid, line_type, key, wired_surface, enhanced3d and color
          
          
           
             _1
             _2
             _3
             _4
             _5
             elevation_grid
             _1
             _2
             _3
             _4
             _5
             elevation_grid
             :
          
        
      
       
         
           
             
             [Maxima Draw2D] ellipse(xc,yc,a,b,φ1,φ2) Ellipse, zentriert bei xc, yc mit den Halbachsen a und b, von Winkel φ1 bis  Winkel φ2. Optionen nticks, transparent, fill_color, border, line_width, line_type, key and color. 
          
          
           
             
             [Maxima Draw2D] ellipse(xc,yc,a,b,φ1,φ2) plots an ellipse centered at [xc, yc] with horizontal and vertical semi axis a and b, respectively,  starting at angle ang1 with an amplitude equal to angle ang2. Options: nticks, transparent, fill_color, border, line_width, line_type, key and color. 
          
          
           
             #1
             #2
             #3
             #4
             #5
             #6
             ellipse
             #1
             #2
             #3
             #4
             #5
             #6
             ellipse
             :
          
        
      
       
         
           
             
             [Maxima Draw2D] errors(e1,e2...) Punkte mit Fehlerbalken, horizontal, vertical oder beide, abhängig von der Option error_type.  Argumente für error_type = x: Listen [x, y, xdelta] oder [x, y, xlow, xhigh]. Argumente für error_type = y; Listen [x, y, ydelta] oder [x, y, ylow, yhigh].  Argumente für error_type = xy oder error_type = boxes: Listen [x, y, xdelta, ydelta] oder [x, y, xlow, xhigh, ylow, yhigh].   Optionen: error_type, points_joined, line_width, key, line_type, color, fill_density, xaxis_secondary, and yaxis_secondary 
          
          
           
             
             [Maxima Draw2D] errors(e1,e2...) Draws points with error bars, horizontally, vertically or both, depending on the value of option error_type.  If error_type = x, arguments are lists [x, y, xdelta] or [x, y, xlow, xhigh]. If error_type = y, arguments are lists [x, y, ydelta] or [x, y, ylow, yhigh].  If error_type = xy or error_type = boxes, arguments are lists [x, y, xdelta, ydelta] or [x, y, xlow, xhigh, ylow, yhigh].   Options: error_type, points_joined, line_width, key, line_type, color, fill_density, xaxis_secondary, and yaxis_secondary
          
          
           
             _
             errors
             _
             errors
             :
          
        
      
       
         
           
             
             [Maxima Draw2D] explicit(f,x,xmin,xmax) zeichnet eine Funktion f von x von xmin bis xmax.  Optionen: nticks, adapt_depth, draw_realpart, line_width, line_type, key, filled_func, fill_color und color
          
          
           
             
             [Maxima Draw2D] explicit(f,x,xmin,xmax) plots explicit function f, with variable x taking values from xmin to xmax.  Options: nticks, adapt_depth, draw_realpart, line_width, line_type, key, filled_func, fill_color and color
          
          
           
             _1
             _2
             _3
             _4
             explicit
             _1
             _2
             _3
             _4
             explicit
             :
          
        
      
       
         
           
             
             [Maxima Draw3D] explicit(f,x,xmin,xmax,y,ymin,ymax) zeichnet eine Funktion f von x und y im Bereich xmin bis xmax und ymin bis ymax  Optionen: draw_realpart, xu_grid, yv_grid, line_type, line_width, key, wired_surface, enhanced3d und color. 
          
          
           
             
             [Maxima Draw3D] explicit(f,x,xmin,xmax,y,ymin,ymax) plots the explicit function f, with variable x taking values from xmin to xmax and variable y  taking values from yminto ymax. Options: draw_realpart, xu_grid, yv_grid, line_type, line_width, key, wired_surface, enhanced3d, and color. 
          
          
           
             #1
             #2
             #3
             #4
             #5
             #6
             #7
             explicit
             #1
             #2
             #3
             #4
             #5
             #6
             #7
             explicit
             :
          
        
      
       
         
           
             
             [Maxima Draw2D] image(Matrix,x0,y0,w,h)  Farbdarstellung einer m x n Matrix entsprechend der Option palette
          
          
           
             
             [Maxima Draw2D] image(matrix,x0,y0,w,h)  plots matrix in the rectangular region from vertex (x0,y0) to (x0+w,y0+h) according to option palette.
          
          
           
             #1
             #2
             #3
             #4
             #5
             image
             #1
             #2
             #3
             #4
             #5
             image
             :
          
        
      
       
         
           
             
             [Maxima Draw2D] implicit(f,x,xmin,xmax,y,ymin,ymax)  2D Darstellung einer implizit gegebenen Funktion im angegebenen Variablenbereich  (marching squares Algorithmus). Optionen: ip_grid, ip_grid_in, line_width,  line_type, key, color
          
          
           
             
             [Maxima Draw2D] implicit(f,x,xmin,xmax,y,ymin,ymax) plots the implicit function defined by f,  with variable x taking values from xmin to xmax, and variable y taking values from ymin to ymax. Options: ip_grid, ip_grid_in, line_width,  line_type, key, color
          
          
           
             #1
             #2
             #3
             #4
             #5
             #6
             #7
             implicit
             #1
             #2
             #3
             #4
             #5
             #6
             #7
             implicit
             :
          
        
      
       
         
           
             
             [Maxima Draw3D] implicit(f,x,xmin,xmax,y,ymin,ymax,z,zmin,zmax)  3D Darstellung einer implizit gegebenen Funktion im  angegebenen Variablenbereich (Marching Cubes Algorithmus). Optionen: x_voxel, y_voxel, z_voxel,   ip_grid_in, line_width, line_type, wired_surface, enhanced3D, color [Maxima Draw]
          
          
           
             
             [Maxima Draw3D] implicit(f,x,xmin,xmax,y,ymin,ymax,z,zmin,zmax) plots the implicit surface defined by f,  with variable x taking values from xmin to xmax, variable y taking values from ymin to ymax and variable z taking values from zmin to zmax.  This object implements the marching cubes algorithm. Options: x_voxel, y_voxel, z_voxel, line_width, line_type, key, wired_surface, enhanced3d,and color
          
          
           
             #1
             #2
             #3
             #4
             #5
             #6
             #7
             #8
             #9
             #10
             implicit
             #1
             #2
             #3
             #4
             #5
             #6
             #7
             #8
             #9
             #10
             implicit
             :
          
        
      
       
         
           
             
             [Maxima Draw2D and 3D] label(list) Beschriftung, im 2D gegeben als Liste (text,x,y), im 3D als Liste (text,x,y,z), spezielle Optionen: color, label_alignment, label_orientation
          
          
           
             
             [Maxima Draw2D and 3D] label(list) text label  specified in 2D as list [text,x,y], in 3D as list [text,x,y,z], Options: color, label_alignment, label_orientation
          
          
           
             _
             label
             _
             label
             :
          
        
      
       
         
           
             
             [Maxima Draw2D] parametric(fx,fy,p,pmin,pmax) parametrisch gegebenen Funktion. Optionen:  nticks, line_width, line_type, key, color, enhanced3d
          
          
           
             
             [Maxima Draw2D] parametric(fx,fy,p,pmin,pmax) plots the parametric function fx, fy  with parameter p taking values from pmin to pmax. Options  nticks, line_width, line_type, key, color, enhanced3d
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           drawEN
        
      
    
     
       
         
           msg
           descriptive
           load
           Maxima
           :
        
      
    
     
       
         
           S
           pidigits.data
           file_search
           read_matrix
           Maxima
           :
        
      
    
     
       
         
           p
           title
           Frequency of the digits in π
           ≡
           S
           piechart_description
           2
           el
           proportional_axes
           xy
           ≡
           xrange
           1
           -
           1.8
           2
           1
           sys
           ≡
           axis_top
           false
           ≡
           axis_bottom
           false
           ≡
           axis_left
           false
           ≡
           axis_right
           false
           ≡
           xtics
           false
           ≡
           ytics
           false
           ≡
           xaxis
           false
           ≡
           7
           1
           sys
           5
           1
           sys
           :
        
      
    
     
       
         
           p
           Draw2D
        
      
    
     
       
         
           xa
        
      
    
     
       
         
           drawEN
        
      
    
     
       
         
           obj
           proportional_axes
           xyz
           ≡
           head_length
           0.1
           ≡
           head_angle
           10
           ≡
           0
           0
           0
           3
           1
           sys
           1
           0
           0
           3
           1
           sys
           vector
           head_both
           true
           ≡
           head_type
           empty
           ≡
           0
           0
           0
           3
           1
           sys
           1
           1
           0
           3
           1
           sys
           vector
           head_type
           nofilled
           ≡
           0
           0
           0
           3
           1
           sys
           1
           1
           1
           3
           1
           sys
           vector
           xyplane
           0
           ≡
           grid
           true
           ≡
           11
           1
           sys
           :
        
      
    
     
       
         
           obj
           Draw3D
        
      
    
     
       
         
           hea
        
      
    
     
       
         
           drawEN
        
      
    
     
       
         
           cmd
           user_preamble
           set polar
           set grid polar ls 100
           unset xtics
           unset ytics
           set yrange [*:*]
           set xrange [*:*]
           unset border
           unset xlabel
           unset ylabel
           set rrange [0:5]
           set rtics 1
           11
           1
           sys
           ≡
           line_width
           2
           ≡
           10
           w
           /
           w
           1
           10
           π
           *
           explicit
           proportional_axes
           xy
           ≡
           4
           1
           sys
           :
        
      
    
     
       
         
           cmd
           200
           200
           2
           1
           sys
           Draw2D
        
      
    
  


Martin Kraska


CHAPTER 4. 2D GRAPHICS OBJECTS

bars(bl; b2; b3...)

This is a low level object for bar charts. The individual bars are given by lists with
position x, height h and width b:

x
h
b

'ksy ="5et: LY
fill color =blue
fill density =0,2
0,8 1,48 2,8
bars 5 HE) HEtak
0,4 0,4 0,4
k=y = "5t B"

) fill color =red

fill density =0,4
line width =2

1,2 2,2 3,2
bars 4 re—2 =5
0,4 0,4 0,4

Xaxls = trus

25

Draw2D (cm ]I

Specifying the bars as individual arguments is uncomfortable.
functions to extract the arguments from a matrix:

You

can use Maxima

123 4 (7
E"'E apply |f: args || 45 & =r|dz:d5: 13
788 i |e
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boxplot_description(M, optionl,...)

Box-and-whisker-plots visualize parameters of random distributions (minimum, maxi-
mum, median, lower and upper quartile). The option range allows to set limits for outliers
in terms of the interquartile range.

M Data matrix m x n, each of the n columns is a sample of m values.
box_width (default 3/4): relative width of the boxes, must be within [0,1].
box_orientation (default vertical): possible values: vertical and horizontal.

range (default o0): Sets a factor f, such that values which are by more than f times
the interquartile range off the box are considered to be outliers. These are marked
with circles and not taken into account for the minimum and maximum indicators.

Usually f =1,5.
outliers_size (default 1): size factor for the outlier-circles.

The function is defined in the Maxima package descriptive, which is not loaded by default
in the Maxima plugin.

In the example we are sampling throws of two dice.

r:E [ load ("descriptive" :Ijl ="C:/maxima-5.47.0/share/maxima/5.47.0/sh

samples ;=5 valuss =10 header = [ l..samples ]
M :=Random,, (values; samples; 1; 6]+ Random,, (values; samples; 1; 6]
1 2 3 = 5
12 O
| 2 | 7 |10 &
T
ol 12| 8 | 5 | 6 |11
G g 2 g 10
A T R
- | 1] 7 12 B 1]
61 | 7|8 |10 7| &
B 3 | 7|98 | 3|11
T & 11| 5 | &
2 L 1 1 1 1 1 .? g 5 2
B 7 4 11
1 2 3 4 5
M

sample

boxplot description [M: range =1,5
I xplot_ p (M: g . 5)

¥1label = "zample"

If you want to specify several options to boxplot_description, then you might consider
Maxima’s mapping features:

=f{a;b; C’}

AL | apply |£;

0o
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ellipse(xc; yc; a; b; ang; delta)

Draws an ellipse centered at xc, yc with the radii a and b, starting at angle ang until

angle ang+delta.

Caution! In Maxima 5.47 delta is multiplied by 2.

Options

nticks Number of sampling points

transparent (true) filled or unfilled sector. Actual transparency must be set by
fill_color in RGBA format.

fill_color

(red) fill color in RGBA format.

border (true) draw the border

line_type (solid) line type for the border

line_width

line width for the border

key (none) legend entry

color (blue) line color

obj =1

(211ipse (0; —2; 3:;0,5; 0; 360)

£fill ecolor = lightblue

color =black

lins width =1

ellipse (0; 0; 2; 2; —30; 30)

£ill color ="4#ff0000aa"

ellipse (0; 0,5; 2; 2; 60; 90)

transpar=nt = true

ellips= (2; 2; 0,8; 0,8; 0; 180)
-3

yrange = 1

proportl onal axes =Xy

xtics axis = trus

ytics axis = true

Draw2D

obJ ;

200
200

Martin Kraska
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errors(11; 12;...)

Plots error bars. The arguments are lists, depending on the type of the error bars.

error_type =X X X
¥ ¥
Ax X
u
X Yy . .
o A non-symmetric symmetric
Srror type =y ¥ % Yu Azr Az
¥ ¥
4y ¥, Ay
¥
i y 1 | : Ay
error type =Xy X X
error typs =boxss ¥ b yL#— -
Ax X | i >
u [ T [
Ay Ix Iy, r TH
(=3
i
(=]
Options
error_type Type of error bars (x, y, xy or boxes)
error Lype =¥
points joined = true 14 F
121 12 |7
4 57 10 = P
EXTOrs |args | l
10 31 8k ‘
17 6 2 - B F L
color = red 4k
error type =boxes 5 b
obj ==« 2 B 12 o
7 9 21 5
EXro¥rs |args 10 5 1 i L 1 1
1 o 5 10 15 20
17 12 — 2
2 x
_3 Draw2D (obj )
Xrange =
g {ED
-3
range =
¥ a 15
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eXpliCit (f(x) R xmin;xmax>

Plots an explicit function y(x) within a given range of the variable z.

T T =
N

=G 4 -2 1] 2 4 4]
x
key="gin(x)"
explicit [sin{x]; X;—2-m; 2-11]
500
Draw2D | {key ="coa{x)" H
¥ (x) : {150
color = red

explicit [cns[:{]; X:—2-m: 2-11]

Use the option filled_func to shade areas between functions (here we use y = 0 as limit)

sin{x)=0 3
sin{x)
k=29
L 1
5 10
filled func =0
fill color = red
fill density=10,4
key="3in(x)>0"
explicit [charfun (sin(x) }G]; X:—4-m: 4 -11]
00
DrawZD | ckey="3in{x)" :
¥ (=) : {150
color = red

filled func = false
explicit [sin{:{]; X:—4-m: 4-11]

{—1,3
yrange = 5
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histogram_description(data; optionl; option2...)

Creates the graphics elements for a histogram plot of a sample data. The specific options
must be given as separate arguments (not as a list). Use apply() to map from a list to
function arguments.

This function is part of the Maxima package “descriptive”. It must be loaded before using
the command.

Options specific to histogram _description

nclasses (10): number of classes or list with the limits and an optional number of

classes :
Lmin
Lmin
Tmax OF
xmax
ng

frequency (absolute) scaling of the class values:
absolute Number of values in the class
relative Fraction of values in the class
percent Fraction of values in %

density Mean density of the distribution (fraction divided by width of the
classes)

htics (auto) Tick location on the horizontal axis. Possible values, auto, endpoints,
intervals or a list with labels

n =100 X:=Raﬂdﬂmw[n;1; 6]—RandamN|[n; 1; 6)
. apply (histogram description: H args )
r
cmd =4 xlabel = "Herc"
nclasses =12, 5 A i
H args = 11 ¥label ="Relative Hiufigkeit in "
frequency =percent 20
fill density =0,2 [ ]
Arguments for £ 151
histogram description = | |
2
[=.]
10}
Lo
: B -
z
-
o
n 1 1 1 1 1 1
2 4 5] 8 10 12
Wert
300
DrawlD | cmd ;
240
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image (Matrix; xmin; ymin; xmax; ymax)

Plots matrices of real values as color values (heat map) in the zy-plane with given axes
limits.

image {Randamm{ltl; 10; 0; 200); 0; 0; 30; 3&]

proportional_axes =XV
obJ = bBlues

palette = white

red

DrawzD [abj ]
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implicit(f(x; y); x; xmin; xmax; y; ymin; ymax)

Plots implicit functions f(x,y) = 0 using the Marching squares algorithm. The sampling
grid is defined by the options
ip_grid Number of sampling intervals in z- and y-direction

ip_grid_in Number of secondary interval

2 3 _ 3 3 2 r =5 r =4
£, =ly =x —-2-x+1 £,=5|lx +y =3-xy —x-1 & ¥

(key = string [fl]

implicit [fl;x; TEILP T iYE T I I'Y]

key = string [f‘?]

color =red

b =9 implicit (£
implici [ PRI Ao (e e ry]
proporti onal aXes = XY 4
key pos =bottom right
xtics =1 Ir
. e,
vEics =1 2| R“‘m‘
*-H.\_H..
'I -
7<\
= 0 1
-1 F
2 b /
stk
=
p () (y 3 ey
5 4 3 2 -1 0
x
. 320
DrawlD |obJ :
230
2 3 : 3 3 2 r =5 r =5
£,7ly =x —2-x+1 f,=lx +y =3-x-y —x-1 * ¥
I
| - 10 .
1 rid =
D 10
4
: ‘4 3 1 3|
1 rid in =
P gre 1 2+
4 . . 'I -
_T.mpl_u:_r.t[f i X —Y ;¥ :¥;—F :F ]
obj = 1 H X ¥ ¥ = 0
color =red -1F
; g ! - L . . - L . 2 I
implicit [f_?, Xp =T T, :¥: - ry] 21 -
proporticnal axes ==Xy 4k
xtics =1 5 I [ N |
ytics =1 5-4-3-2-1012345
¥
. 220
DrawD | ob]J :
220
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label(listl, list2,...)

Inserts text labels at specified locations. The arguments are lists of three entries

text
T

Y
Options
label_alignment horizontal alignment: center (default) or left, right

label_orientation horizontal (default) or vertical

0,1
range =
¥ a 1,4 12|
. 08 MHWIA TEXT
i =0,3

iy ! = 06 F grounar Text
color = red 03 b red hext

"red text"®

-1 0 1
label 0
x
0,3
. 250
color = forest gresn Draw2D | ob7J ; 12h
ob] =4 "griiner Text"™

1lab=1 0

0,6
color =kblue
label alignment = left

1v | 1abe1 "oHMHMHA TexT" 00,9
a abel ; args
il g "a b+ c"3 =a"01,2
-1
Xrange =
ol 1
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parametric(x(t); y(t); t; tmin; tmax)

Parametric functions.

10

a5 | explicit
ap | parametric —
25 - ————
=20 —
15 :
£
S i

key="explicit™

| — X
explicit [e rxr —1:; 3]
{calar=red {350

DrawzD x
180

r

key = "parametric"

. 2
parametric [z-ccs[r]; r ;r;0; E-IJ]

key pos = top left
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piechart\_description(data; optionl; option2...)

Pie chart. data is a list or a vector. The options need to be provided as function
arguments.

The function returns a list of lists. The second entry of top level list is the actual diagram
object. Therefore, the function has to be used with index 2 as in the example.

The diagram is assembled using ellipse() objects, Therefore it suffers from a bug in
Maxima 5.47 (sector angle is double the specified value).

Options

sector_colors (random) list with sector colors

0 center of the pie

pie_radius (1) radius of the pie

: {0
pile_center

msg == load |descriptive
. M| ( )

g = F;E, [read_matrix [file_search I:"pidigits L data"]]]

(title = "Frequency of the digits in o"

piechart description [ = :]

proportional_axes = xy Frequency of the digits in m

=1
KErange = % 18
D=4 raxis_top =false
axis bottom = false
axis left = false

<axls right = false

o 08~ R e G RS e O

xtics = false
vtics = false

xaxlis =false
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points(matrix)

Plot points from
e a matrix of two columns (first column: z-values, second column: y-values) or

e a matrix of two rows and more than two columns (first row: z-values, second row:
y-values) or

e a row or column vector (entries taken as y-value, index taken as z-value)
Options
point_size (1)
point_type (plus). Point type given as number or as name, see section (3.5).
points_joined (false):
false no additional lines
true connect points by lines

impulses vertical lines to the z-axis

points joined = Ltrue
points [R,andDmI:ED; 2]]

proportiona 1 3xes =HY

cm == 0
Xranges = {1

0 =
yrange = {1

Draw2D [cm]l

Random yvalues plotted over their index

04 F
03 F
Sl | HH Ll |
o il il U L
AL ‘ ‘w”lH ‘| \'\‘
0.2
03 F
04T 1 1 1
10 20 30 40 100
x
points joined = impulses ann
DrawzD . | H
points (Random(100; 1)-0,5) {150
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polar(r; phi; min; max)

2D-curve, given in polar coordinates r(¢p).

Note that the grid still remains Cartesian.

To produce a plot with a polar grid, you have to specify the grid with gnuplot preamble
commands and use the explicit() graphics object.

nticks =200

—q 3
Xrange = %4
al
= —— -3
cmd._ayraﬂgu-{a AL
line width =2 f\
10 AL @
polar |—::w: 12 10-1
v 1L
2|
-3 1 1 1 1 1 1
-4 -3 2 1 0 1 2 3 4
x
Draw2D | cmd )
( "set polar"
"set grid poclar 1= 1007
"unset xtics"
"unset ytics"
"set yrange [*:z*]"
ussr preamblse =4"set Xrange [*:*]"
"unset border™
cmd =+« "unset xlabel"
"unset ylabel" 72 3 4 5
"set rrange [0:5]"
"set rtics 1"
line width =32
explicit %gq Vo l;lD-n’
prsporti:-ﬂal_a:{es =XV Drawz2D | cmd : {233 ]
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polygon ()

Filled polygon. Arguments:

e Two lists: one containing the x-values and the second containing the y-values.

2254

glygon ; args
pol¥g g 1210

apply =polygon

-

r

W LA B3 B
L

e One lists of n lists: each containing the rand y-values of a vertex.

3
2
3z 7
Z 2
olygon |args =polygon
&YX | polyg as || ¢ & polygon |q.
55 4
5
5
Here we demonstrate both versions.
line width =2 .
fill color ="#LLfL00EE"
5 ] 2254 4
a a on :; args
poly (Dolyg g 1310 i
! f111l color ="#ff0000EBE" =
oby ==« - 2
32
¥ 72 1
o on |args
polyg g 6 4
ﬂ L i 1 1
A3 2 3 4 & B T
proporti onal axXes =Xy "
. 200
Draw2D | obk] ;
200
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quadrilateral(pl; p2; p3; p4)

This is an alternative to a polygon with four points. Yet the input is different, each
argument is a two-element list with the vertex coordinates.

. 0 1 0 -1
gquadrilateral E |- :
-1 i} 1 0
ohy = prﬂportiﬂnal_a:{es =Xy

xlabel =""
¥labsl =""

-1 05 0 05 1

. 150

Draw2D | obk7J :
150
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rectangle(pl; p2)

Rectangle, drawn between two points given as coordinate lists.

(line width =3
lins_typs = short long dashes
fill ecolor =red

e

transparent = true

rectangle

line type =solid

em:=4J1line width=1

[

-3
10

yrangs = {;35 -2 o 2 4 G 8 10
r

rectangle

Xrange = {

¥
W P o= O = MW & ;oo
1

proporti onal axXes =Xy
DrawzD [cm;'l
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region(condition; x; xmin; xmax; y; ymin; ymax)

Fill a region within the given limits, where it meets a given logical condition.

R = i{[xz_yz]{l
4
x wvoxsl =30
¥_voxel =30 1.5
903 Fregion |Rrx:—2: s y; -2 2 1
2 2 2 2 0.5
prﬂportiﬂnal_a:{es =Xy - 0

-1.5
151 05 0 05 1 1.5

X

200

ob7
J 200

Draw2D
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triangle(pl;

p2; p3)

Triangle given by three lists of vertex coordinates.

D :=DrawiZD| <

£fill color ="§0000ff88"

b

praportional_axes =XV
border = falzse

triangle

triangle

bo o)

!

Martin Kraska
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vector(p; d)

Arrow with vector components d starting at point p. Both arguments are lists with 2
coordinate entries.

Options
head_angle (45) Angle between the arrow heads and the segment in °
head_both (false) A single head if false or two heads if true
head_length (2) Head length in units of the z-axis
head_type (filled): filled, nofilled: open, empty: closed but not filled

unit_vectors (false)if true, the vector is scaled to length 1.

'prﬂp ortiona 1 axes = XY=
head angls =10

3 S
1" |5
head both = true

head length =1
obj = h=ad type = csmpty

bt

unit vectors = trues

vector

vector

head angle =90

5 3
27 1o DrawzZD

230
200

vector

Clbj;{
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5 3D Graphics Objects

Contents
cylindrical . . . . . . . .o 62
elevation grid . . . . . ..o o000 oL 63
explicit . . . . .o L 64
explicit . . . . .. 65
implicit . . . . .o 66
parametric . . ... oL oL Lo e 67
parametric_surface . . . . . ... ..o 68
points . . . ... oL e 70
quadrilateral . . . . .. oo 71
spherical . . . . . . .. 72
triangle . . . . . oL L L 73
tube . . .o 74
vector ... oL Lo e 76

Here we demonstrate the available objects for 3D graphics, i.e. for use with Draw3D() or
the Draw3D region. For some of the objects, we also explain some of the most important
options. The Draw Description snippet is a good source on available options.
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CHAPTER 5. 3D GRAPHICS OBJECTS

cylindrical (I(Z 5 90) s < 5 Zmin s “max > ¥ s Pmin » meax)

This function plots surfaces given by the radius as a function of z and of the azimuth
angle .

7
G
2 r 5
1.1 C 14
ﬂa - 3
z B 2
ﬂ? - 1
A5 F o
2k
B
£
¥
® 4 & B
darkwviolet
pralette =
yvellow
Draw3D

enhanced3id =g
cylindrical [4—2; 2 —2:2:w;0; 2-|1]

This is an example of how to color the plot based on the angular coordinate and based
on a custom palette.
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elevation_grid(M; z¢; yo; w; h)

3D representation of a m x n matrix of z-values. M, corresponds to x = xg and y = yo+h,
M., corresponds to x = xg + w and y = yp.

The example shows a 8 x 6 random matrix with a custom color palette. In Gnu-

plot, the faces have uniform color.
interpolate_color option can be used.

Ztics =0,5

JA1]

pal=tt

obj =4

0

Zrange = { 5

chtics =0,

darkblue
blues
lightblue
green
khaki

browvn

2

| 5
interpolate color= { 5

In order to have color gradients on a face, the

(e1evation grid (Randem(8; 6); 0:0; 4; 3)

=2 = M
(=1 s T T2 T

DrawiD

objJ ;

2410

Martin Kraska
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explicit(z(x; y); x; xmin; xmax; y; ymin; ymax)

Plots explicit functions z(x,y) within given ranges of the variables x and y.
Options:

palette list of colors. (color) The value from enhanced3D is uniformly mapped to
this list.

enhanced3d (z) how to generate values for coloring. Specified as list with the
entries f(x,y,z2),x,y, 2

2 2
| -—X —¥
gauss ‘=explicit |Z20-e —10; X:; —5:; 5; ¥vr —5; 5

planse :=explicit [x—y; X —4:4:y=—4- 4]

'iﬂtsrpﬂla te color = trus
xu_grid =30
¥v_grid =30
bBlue
pal=stte = qy=llov 10
| red a3
ob] =5 gauss 0
plane -5
-10
. 70
Viey =
30
—10
Zrange =
g 10
: 250
Draw3D | obj ;
250

Here we use the default color map to color by the distance from the zy-plane f = |z|.

f=explicit [sin(x -y]; X —3:3;y:—3; 3]

' |z

enhanced3d =

¥
Z 1
£
cmd =«
-2 0.5
Zrange =
T 2
: ‘ 0
cbtics =0,5 ¥

xyplans =0

grid = true

Draw3D

300
cmd ;
{2‘10]
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implicit (f(xa Y, Z) > L5 Tmin s Lmax > Y s Ymin > Ymax » Z;Zmin;zmax)

Visualization of implicit functions f(x,y, z) = 0 within the given range of the variables.

e Number of intervals for the Marching Cubes Algorithm is set by the options x_voxel,
y_voxel, z_voxel.

Z 2 2 2 2 2
Ff=|lx +wv +=z -—-1)lx +[y-1,5) +=z -0,5|=0,015
( white
pal=tte = B
vhite

X _voxel =15
¥ _voxsl =15
z vorel =15
implicit (f;x; —1;1;y; —1,2;2,3;2; —1;:1)
ussr preamble ="set view 70, 120, 2.8, 1.4"
colorbox = false

ob7j =1

proportl onal axes = XyE
xyplane =0 1r

300

Draw3D | obJ :
180
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label(listl, list2,...)

Inserts text labels at specified locations. The arguments are lists of four entries

text
T

Y
z

Options
label_alignment horizontal alignment: center (default) or left, right

label_orientation horizontal (default) or vertical

sin(x )+ cos [xz]

explicit |e s xX; —3;3;v:—3:3
color = red
"Berg 1" "Berg 2"
-2 1
label 5 : 5
5
2 5 3 .
cbi =« color =kblue 3 4
label orientation =vertical z ? ;
“'I‘al“ ﬂ 1
-1,5 -1 0
label
-3 -1
70 y
View =
350

Draw3D (ob7j )
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parametric(fx; fy; fz; t; tmin; tmax)

Parametric curve, given by three functions of parameter t. The sampling density is con-
trolled by option nticks.

i

u
enhanced3d ={
u

nticks =100

2
parametric [cDSI:E-U]] - sinf:'?-ujl: u—2:u; 0; 2]
line width =3

obj = /parametric [t; sin(lﬂ-t]; cns[lﬂ-t]; tr: —2; CI]

. 70
vView = {SD
xtics =1
viics =1 )
stics =1 1
cbtice =1 a
2
1
¥

200
200

Draw3D

Gb‘j;{
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parametric_surface(fx;fy;fz;u;umin;umax;v;vmin;vmax)

Parametric surface, given by three functions of two parameters. The following example
is inspired by the Gnuplot examples page. The sampling density of the parameters is
controlled by the options xu_grid and yv_grid.

g =1 fxzzz-a-[cc-ﬂ[u]fu-sin[u]]-sin[v]

1+ r_tz-[SZi.nnl[v]]2

2-&-[ﬂin[u]—u-cos[u]]-sinl{v]

£y =
1+ uz-[sin{vnz

tg[ff]];' 2-cos (v)

1+u2-|[51n[v:|:|

axis 3d = false
colorbox = false

fz:=a-1n

xu grid =51 2

ob] = ¥v _grid =51
user_preamble={"set view 120, 357, 1.75, 1.0"

parametric_surface [fx; Ty f2r U —4, 94,9 v 0,05 H—CI,DE]

Draw3D

. {400]
obJ

300
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http://gnuplot.sourceforge.net/demo_svg/transparent_solids.html
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This example is from the Maxima documentation:
fx :=%-cosl{u]-[cos[v}|+1]

f}'::%-sin{u]-(cns[v}l+1]

2

+3
¢ —20

B

fz ==u-sin|[v]—[

ussr_prsambls:{"set view 100, 320, 1, 1.5"
xu grid =150
obj =syv_grid =25
parametric_surface [f.:u'; fy;, fz; uy;0;13-m; v; —m; |:|]

xyplan=se =0

-50

-100
-150
-200
-250
-300
-350
=400

Draw3D (obj )
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points(matrix)

Plot points at (z,y, z) given by
e a 3 x n matrix, each column is a point or
e a n x 3 matrix, each row is a point.
Options

enhanced3d (color) coloring of the points. If you specify a list of two entries.j

is the index of the point in the matrix (row index) and f(j) is an arbitrary
function of that index

{f@)
J
point_size (1)

point_type (plus). Point type given as number or as name.

points_joined (false):
false no additional lines

true connect points by lines (color is averaged between adjacent points)

impulses vertical lines to the z-axis

i

k
enhancedid = &

points [RandDm |: 100 ; 3]]

proporti onal axes = Xy=

0
EXrange =
ol 1
%n
Frangs = J

0
Erange =
=l 1

chtics =20

colorbox ="Point index"
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quadrilateral(pl; p2; p3; p4)

This draws a quadrilateral. Each argument is a three-element list with the vertex coordi-

nates.

i

lightblue

palette = -
lightblue

0 2

xyplane =0
iﬂtsrp:-lats_c:-lor = true
colorbox = false
) 70
View =
110

xtics=0,5

vEics =0,5

i) 1 0
gquadrilateral |«0: <02 <1:

200
Draw3D |cm:

200

Martin Kraska
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spherical(r; a; amin; amax; z; zmin; zmax)

Surface given by a radius r(«, ) in spherical coordinates with « being the azimuth angle
counted from the z-axis and f being the angle from zenith (north pole).

user_prsamble:{"set view 60, 30, 1.0, 1.2"

spherical [l; gg1:0;2-o; zen; 0; n]

cmds = pr?pﬂrtlﬂﬂal_axes = XVE
xtics =0,5
vEics =0,5

xyplanse =—1

Draw3D (cmds )
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triangle(pl; p2; p3)

Triangle given by three lists of vertex coordinates.

interpolate color = true

(fo (1 (o
triangle 41[1; ol {1
a 1) 200
1 7 g {:mu
0 1
0

p -=Draw3D i
triangle 41

S

| o B s R
.

lprcpcrticna 1 axes = xy=z
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tube(x; y; z; r; p; min; max)

Tubular surface, given by center line coordinates x,y, z and radius r as function of the
path parameter p.

The example is a Klein bottle. The individual parts have colors assigned, which are only
relevant for the surface grid.

2:=2,5 b:=1,5 ¢:=2 d:=

bottle

rcalar =kblues

tube

tub=

.— Jeolor = red

color = forest green

color =magenta

3

0;0;(—a)-sin(t); a+b-cos(t): t; ﬂ;g

0:0: [_a}-Sin{t]; E+b-|:1]5[:t]: t: %: o

tubs (0; 0; d-t;a+b-cos(t); t;0;m
tubs (c—c-cos(t); 0;d-t;a—b; t; 0; n)

tub= [c—c-cosft]; 0: d-u+c-5in[t]; a—b;:Lt;0; n]

Here we use a non-standard palette for coloring by path parameter.

ohy =4

ussr preambls = %

xu_grid =50
¥v _grid =29

E
enhanced3d = %t

bBlue

green
paletie =

vellow

red
xyplan=e =0

proporti onal aXes = XY=

R

chtics = 5=t

bottle

|

"zet style £ill transparent scolid 0.77
"set view 60, 30, 1.3, 1.1"

. 250
Draw3D |ok7J :
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The same plot with surface grid instead of shading. Shading is disabled using enhanced3D=none.
The surface grid respects the color specification.

ruser_pream_ble ={"5E1.: view 60, 30, 1.3, 1.1"

enhanced3d = none

xu _grid =10

¥v_grid =20

B xyplane =0

oby ==« -
surface hides = trus

proporti onal aXes = HYE

RS

chtics = st

bottle
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vector(p; d)

Arrow with vector components d starting at point p. Both arguments are lists with 2
coordinate entries.

Options
head_angle (45) Angle between the arrow heads and the segment in °
head_both (false) A single head if false or two heads if true
head_length (2) Head length in units of the z-axis
head_type (filled): filled, nofilled: open, empty: closed but not filled

unit_vectors (false)if true, the vector is scaled to length 1.

'prﬂp ortiona 1 axes = XY=
head length=0,1

head angle =10

0 1

vector |<0: 50

r

0 0

h=ad both = trus
head type = empty

ob7j = o (1 .
vactor [¢0: <1
0 Qo
head types =nofilled
0 1
vector |<0: <1
0 1
xy¥yplan=se =0
grid = true Draw3D (ob7 )
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6 Curve Fitting

Contents
6.1 Fit of a Cubic Parabola to 5 Random Points . . . . . . . . . 78
6.2 Fit ofaCircleto4 Points . . . . . . . . . . . . .. ... ... 79
6.3 Fit of Piecewise Continuous Functions . . . . . . . . . . ... 80

-i Fit.sm

The function Fit () is an interface to Maxima’s Isquares package for fitting mathematical
models to data. It is augmented by MSE() and Residuals () for evaluation of the quality of
the fit and Assign() for converting the result represented by equations into assignments.

Fit(data; vars; eqn; pars; init; tol)
data (matrix) Given data. Each line is a a data point, each column is a variable.
vars (list) Names of variables, one for each column in data.

eqn Equation or expression (which will augmented by = 0), which contains the
Variables listed in vars vars and the model parameters listed in pars.

pars (list) Names of the free model parameters in eqn.
init (list) Initial values for the numeric search for optimal parameter values.
tol (optional number) Tolerance for the precision of the model parameters.

The function returns a list of Boolean equations parameter = value. This list can be
used for value assignment using the function Assign() , e.g. if you want to plot the model
curve.

The quality of the curve fit can be evaluated using the functions MSE() and Residuals(),
which return the mean square error and the deviation between model and data respec-
tively.

Note that the fit is a numeric procedure. The result may depend on the initial values of
the parameters.
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             head_length
             head_length
             :
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             label_alignment
             label_alignment
             :
          
        
      
       
         
           
             
             [Maxima Draw] label_orientation (=horizontal) oder vertical: Ausrichtung von Texten.
          
          
           
             
             [Maxima Draw] label_orientation (=horizontal) or vertical: orientation of text labels.
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             label_orientation
             :
          
        
      
       
         
           
             
             [Maxima Draw] line_type (=solid) Linienart. Alternativen: dots (für alle Formate) oder wenn von Gnuplot unterstützt: dashes, short_dashes, short_long_dashes, short_short_long_dashes. 
          
          
           
             
             [Maxima Draw] line_type (=solid) line type. Other options: dots (for all formats) or if supported by Gnuplot: dashes, short_dashes, short_long_dashes, short_short_long_dashes. 
          
          
           
             line_type
             line_type
             :
          
        
      
       
         
           
             
             [Maxima Draw] line_width (=1) Linienstärke, >0. 
          
          
           
             
             [Maxima Draw] line_width (=1) line width, >0. 
          
          
           
             line_width
             line_width
             :
          
        
      
       
         
           
             
             [Maxima Draw] logcb (=false) oder true: logarithmische Farbskale. Globale Option.
          
          
           
             
             [Maxima Draw] logcb (=false) or true: log scale of the colorbar. Global option.
          
          
           
             logcb
             logcb
             :
          
        
      
       
         
           
             
             [Maxima Draw] logx (=false) oder true: logarithmische x-Achse. Globale Option.
          
          
           
             
             [Maxima Draw] logx (=false) or true: log scale of x-axis. Global option.
          
          
           
             logx
             logx
             :
          
        
      
       
         
           
             
             [Maxima Draw2D] logx_secondary (=false) oder true: logarithmische zweite x-Achse. Globale Option.
          
          
           
             
             [Maxima Draw2D] logx_secondary (=false) or true: log scale of secondary x-axis. Global option.
          
          
           
             logx_secondary
             logx_secondary
             :
          
        
      
       
         
           
             
             [Maxima Draw] logy (=false) oder true: logarithmische y-Achse. Globale Option.
          
          
           
             
             [Maxima Draw] logy (=false) or true: log scale of y-axis. Global option.
          
          
           
             logy
             logy
             :
          
        
      
       
         
           
             
             [Maxima Draw2D] logy_secondary (=false) oder true: logarithmische zweite y-Achse. Globale Option.
          
          
           
             
             [Maxima Draw2D] logy_secondary (=false) or true: log scale of secondary y-axis. Global option.
          
          
           
             logy_secondary
             logy_secondary
             :
          
        
      
       
         
           
             
             [Maxima Draw] logz (=false) oder true: logarithmische z-Achse. Globale Option.
          
          
           
             
             [Maxima Draw] logz (=false) or true: log scale of z-axis. Global option.
          
          
           
             logz
             logz
             :
          
        
      
       
         
           
             
             [Maxima Draw] nticks (=29): Punktezahl für die Kurvenabtastung
          
          
           
             
             [Maxima Draw] nticks (=29): number of points for curve sampling (explicit and parametric)
          
          
           
             nticks
             nticks
             :
          
        
      
       
         
           
             
             [Maxima Draw] palette (=color) Standard-Farbpalette, gray: Graustufen, Liste [Farbe1, Farbe2...]: Interpolation über die gegebenen Farben. Globale Option. 
          
          
           
             
             [Maxima Draw] palette (=color) default color palette, gray: gray levels, or list [color1, color2...]: interpolation over the given set of colors. Global option. 
          
          
           
             palette
             palette
             :
          
        
      
       
         
           
             
             [Maxima Draw] point_size (=1) Größe von points()-Symbolen.
          
          
           
             
             [Maxima Draw] point_size (=1) size of points()-symbols.
          
          
           
             point_size
             point_size
             :
          
        
      
       
         
           
             
             [Maxima Draw] point_type (=1) Symbol für points()-Objekte, Name oder Kennzahl: none -1, dot 0, plus 1, multiply 2, asterisk 3, square 4, filled_square 5, circle 6, filled_circle 7, up_triangle 8, filled_up_triangle 9, down_triangle 10, filled_dwn_triangle 11, diamant 12, filled_diamant 13
          
          
           
             
             [Maxima Draw] point_type (=1) type of points() objects, name or key number: none -1, dot 0, plus 1, multiply 2, asterisk 3, square 4, filled_square 5, circle 6, filled_circle 7, up_triangle 8, filled_up_triangle 9, down_triangle 10, filled_down_triangle 11, diamant 12, filled_diamant 13
          
          
           
             point_type
             point_type
             :
          
        
      
       
         
           
             
             [Maxima Draw] points_joined (=false), true oder impulses: Verbindungsart von points()-Objekten
          
          
           
             
             [Maxima Draw] points_joined (=false), true or impulses: how to join points
          
          
           
             points_joined
             points_joined
             :
          
        
      
       
         
           
             
             [Maxima Draw] proportional_axes (=none), xy oder xyz: Achsen mit gleicher Skalierung). Globale Option.
          
          
           
             
             [Maxima Draw] proportional_axes (=none), xy or xyz: set axes of equal scaling). Global option.
          
          
           
             proportional_axes
             proportional_axes
             :
          
        
      
       
         
           
             
             [Maxima Draw3D] surface_hide (=false) oder true: Ausblendung verdeckter Flächen bei Linienrasterdarstellung. Nur relevant wenn enhanced3D=false.
          
          
           
             
             [Maxima Draw3D] surface_hide (=false) or true: handling of hidden lines in surface grids. Only relevant if enhanced2d=false.
          
          
           
             surface_hide
             surface_hide
             :
          
        
      
       
         
           
             
             [Maxima Draw] terminal (=screen) Ausgabeart. screen: Separates Ausgabefenster, png, jpg, gif, eps, svg, pdf, animated_gif: Gnuplot Ausgabeformat. Globale Option. Nur für Experten. Nutzen Sie das Name-Argument von Draw2D()/3D().
          
          
           
             
             [Maxima Draw] terminal (=screen) separate interactive terminal window,  png, jpg, gif, eps, svg, pdf, animated_gif: gnuplot output format. Global option. Only for experts. Use name argument of Draw2D/3D instead.
          
          
           
             terminal
             terminal
             :
          
        
      
       
         
           
             
             [Maxima Draw] title (="") Überschrift für das Diagramm. Globale Option.
          
          
           
             
             [Maxima Draw] title (="") headline for the plot. Global option
          
          
           
             title
             title
             :
          
        
      
       
         
           
             
             [Maxima Draw] transform (=none) Koordinatentransformation, für 2D als Liste [f1(x,y), f2(x,y), x, y], für 3D als Liste [f1(x,y), f2(x,y), f3(x, y, z), x, y, z]
          
          
           
             
             [Maxima Draw] transform (=none) co-ordinate transformation, for 2D as list [f1(x,y), f2(x,y), x, y], for 3D as list [f1(x,y), f2(x,y), f3(x, y, z), x, y, z]
          
          
           
             transform
             transform
             :
          
        
      
       
         
           
             
             [Maxima Draw] transparent (=false) oder true: ob Rechtecke, Polygone oder Ellipsen transparent sein sollen (bei false werden sie gefüllt). Für echte Transparenz nutzen Sie die Option color mit dem Transparenzwert aa der RGBA Farbspezifikation "#rrggbbaa". 
          
          
           
             
             [Maxima Draw] transparent (=false) fill objects with border, true: don't fill (make them transparent). For actual transparency use RGBA color "rrggbbaa" with the color option.
          
          
           
             transparent
             transparent
             :
          
        
      
       
         
           
             
             [Maxima Draw] unit_vectors (=false) oder true: Vektoren in originaler Länge oder als Einheitsvektoren zeichnen.
          
          
           
             
             [Maxima Draw] unit_vectors (=false) draw vectors in original length, true: draw unit vectors.
          
          
           
             unit_vectors
             unit_vectors
             :
          
        
      
       
         
           
             
             [Maxima Draw] user_preamble (="") Zeichenkette oder Liste von Zeichenketten, die unmittelbar vor dem eigentlichen Diagrammbefehl an Gnuplot übergeben werden. Globale Option.
          
          
           
             
             [Maxima Draw] user_preamble (="") string or list of strings, gnuplot commands placed  immediately before the plot commands. Global option
          
          
           
             user_preamble
             user_preamble
             :
          
        
      
       
         
           
             
             [Maxima Draw] view (=(60,30)) Blickrichtung (Zenithwinkel von z aus, Azimutwinkel von x aus). Globale Option.
          
          
           
             
             [Maxima Draw] view (=(60,30)) view direction (zenith angle from z, azimut angle from x). Global option.
          
          
           
             view
             view
             :
          
        
      
       
         
           
             
             [Maxima Draw] wired_surface (=false) oder true: Gitternetz auf eingefärbten Flächen anzeigen oder nicht. Globale Option.
          
          
           
             
             [Maxima Draw] wired_surface (=false) no grid on colored surfaces, true: draw grid on surfaces. No color control. Global option.
          
          
           
             wired_surface
             wired_surface
             :
          
        
      
       
         
           
             
             [Maxima Draw3D] x_voxel (=10) x-Bereichsteilung für den Marching-Cubes-Algorithmus bei implizit gegebenen Flächen.
          
          
           
             
             [Maxima Draw3D] x_voxel (=10) number of x steps for the Marching Cubes algorithm (for implicit 3D functions). Also used for region().
          
          
           
             x_voxel
             x_voxel
             :
          
        
      
       
         
           
             
             [Maxima Draw3D] y_voxel (=10) y-Bereichsteilung für den  Marching-Cubes-Algorithmus bei implizit gegebenen Flächen.
          
          
           
             
             [Maxima Draw3D] y_voxel (=10) number of y steps for the Marching Cube algorithm (for implicit 3D functions). Also used for region().
          
          
           
             y_voxel
             y_voxel
             :
          
        
      
       
         
           
             
             [Maxima Draw3D] z_voxel (=10) z-Bereichsteilung für den Marching-Cubes-Algorithmus bei implizit gegebenen Flächen.
          
          
           
             
             [Maxima Draw3D] z_voxel (=10) number of z steps for the Marching Cube algorithm (for implicit 3D functions). 
          
          
           
             z_voxel
             z_voxel
             :
          
        
      
       
         
           
             
             [Maxima Draw] xaxis (=false) oder true: Anzeige der x-Achse. Globale Option.
          
          
           
             
             [Maxima Draw] xaxis (=true): draw x-axis. false: don't draw x-axis. Global option
          
          
           
             xaxis
             xaxis
             :
          
        
      
       
         
           
             
             [Maxima Draw] yaxis (=false) oder true: Anzeige der y-Achse. Globale Option.
          
          
           
             
             [Maxima Draw] yaxis (=true): draw y-axis. false: don't draw y-axis. Global option
          
          
           
             yaxis
             yaxis
             :
          
        
      
       
         
           
             
             [Maxima Draw3D] zaxis (=false) oder true: Anzeige der z-Achse. Globale Option.
          
          
           
             
             [Maxima Draw3D] zaxis (=true): draw x-axis. false: don't draw x-axis. Global option.
          
          
           
             zaxis
             zaxis
             :
          
        
      
       
         
           
             
             [Maxima Draw] xaxis_color (=black) Farbe x-Achse. Globale Option.
          
          
           
             
             [Maxima Draw] xaxis_color (=black) color of the x-axis. Global option.
          
          
           
             xaxis_color
             xaxis_color
             :
          
        
      
       
         
           
             
             [Maxima Draw] yaxis_color (=black) Farbe y-Achse. Globale Option.
          
          
           
             
             [Maxima Draw] yaxis_color (=black) color of the y-axis. Global option.
          
          
           
             yaxis_color
             yaxis_color
             :
          
        
      
       
         
           
             
             [Maxima Draw3D] zaxis_color (=black) Farbe z-Achse. Globale Option.
          
          
           
             
             [Maxima Draw3D] zaxis_color (=black) color of the z-axis. Global option
          
          
           
             zaxis_color
             zaxis_color
             :
          
        
      
       
         
           
             
             [Maxima Draw2D] xaxis_secondary (=false) oder true: Nutzung einer zweiten x-Achse (oben) für die nachfolgenden Objekte.
          
          
           
             
             [Maxima Draw2D] xaxis_secondary (=false) or true: use the secondary x-axis (top) for subsequent objects.
          
          
           
             xaxis_secondary
             xaxis_secondary
             :
          
        
      
       
         
           
             
             [Maxima Draw2D] yaxis_secondary (=false) oder true: Nutzung einer zweiten y-Achse (rechts) für die nachfolgenden Objekte
          
          
           
             
             [Maxima Draw2D] yaxis_secondary (=false) or true: use the secondary y-axis (right) for subsequent objects
          
          
           
             yaxis_secondary
             yaxis_secondary
             :
          
        
      
       
         
           
             
             [Maxima Draw] xaxis_type (=dots) oder solid: Linienart der x-Achse. Globale Option.
          
          
           
             
             [Maxima Draw] xaxis_type (=solid) or dots. Global option.
          
          
           
             xaxis_type
             xaxis_type
             :
          
        
      
       
         
           
             
             [Maxima Draw] yaxis_type (=dots) oder solid: Linienart der y-Achse. Globale Option.
          
          
           
             
             [Maxima Draw] yaxis_type (=solid) or dots. Global option.
          
          
           
             yaxis_type
             yaxis_type
             :
          
        
      
       
         
           
             
             [Maxima Draw3D] zaxis_type (=dots) oder solid: Linienart der z-Achse. Globale Option.
          
          
           
             
             [Maxima Draw3D] zaxis_type (=solid) or dots. Global option.
          
          
           
             zaxis_type
             zaxis_type
             :
          
        
      
       
         
           
             
             [Maxima Draw] xaxis_width (=1) Linienbreite der x-Achse. Globale Option.
          
          
           
             
             [Maxima Draw] xaxis_width (=1). Global option
          
          
           
             xaxis_width
             xaxis_width
             :
          
        
      
       
         
           
             
             [Maxima Draw] yaxis_width (=1) Linienbreite der y-Achse. Globale Option.
          
          
           
             
             [Maxima Draw] yaxis_width (=1). Global option
          
          
           
             yaxis_width
             yaxis_width
             :
          
        
      
       
         
           
             
             [Maxima Draw3D] zaxis_width (=1) Linienbreite der z-Achse. Globale Option.
          
          
           
             
             [Maxima Draw3D] zaxis_width (=1). Global option.
          
          
           
             zaxis_width
             zaxis_width
             :
          
        
      
       
         
           
             
             [Maxima Draw] xlabel (="") x-Achsenbeschriftung. Globale Option.
          
          
           
             
             [Maxima Draw] xlabel (="") label of the x-axis. Global option
          
          
           
             xlabel
             xlabel
             :
          
        
      
       
         
           
             
             [Maxima Draw] ylabel(="") y-Achsenbeschriftung. Globale Option.
          
          
           
             
             [Maxima Draw] ylabel (="") label of the y-axis. Global option
          
          
           
             ylabel
             ylabel
             :
          
        
      
       
         
           
             
             [Maxima Draw] zlabel (="") z-Achsenbeschriftung. Globale Option.
          
          
           
             
             [Maxima Draw] zlabel (="") label of the z-axis. Global option
          
          
           
             zlabel
             zlabel
             :
          
        
      
       
         
           
             
             [Maxima Draw] xlabel_secondary (="") Beschriftung der zweiten x-Achse. Globale Option.
          
          
           
             
             [Maxima Draw] xlabel_secondary (="") label of the secondary x-axis. Global option
          
          
           
             xlabel_secondary
             xlabel_secondary
             :
          
        
      
       
         
           
             
             [Maxima Draw] ylabel_secondary (="") Beschriftung der zweiten y-Achse. Globale Option.
          
          
           
             
             [Maxima Draw] ylabel_secondary (="") label of the secondary y-axis. Global option
          
          
           
             ylabel_secondary
             ylabel_secondary
             :
          
        
      
       
         
           
             
             [Maxima Draw] xrange (=auto) oder Liste [min,max]: x-Achsenbereich. Globale Option.
          
          
           
             
             [Maxima Draw] xrange (=auto) or list [min,max]: range of the x-axis. Global option
          
          
           
             xrange
             xrange
             :
          
        
      
       
         
           
             
             [Maxima Draw] yrange (=auto) oder Liste [min,max]: y-Achsenbereich. Globale Option.
          
          
           
             
             [Maxima Draw] yrange (=auto) or list [min,max]: range of the y-axis. Global option
          
          
           
             yrange
             yrange
             :
          
        
      
       
         
           
             
             [Maxima Draw] zrange (=auto) oder Liste [min,max]: z-Achsenbereich. Globale Option.
          
          
           
             
             [Maxima Draw] zrange (=auto) or list [min,max]: range of the z-axis. Global option.
          
          
           
             zrange
             zrange
             :
          
        
      
       
         
           
             
             [Maxima Draw] xrange_secondary (=auto) oder Liste [min,max]: Bereich der zweiten (oberen) x-Achse. Globale Option.
          
          
           
             
             [Maxima Draw] xrange_secondary (=auto) or list [min,max]: range of the secondary (top) x-axis. Global option.
          
          
           
             xrange_secondary
             xrange_secondary
             :
          
        
      
       
         
           
             
             [Maxima Draw] yrange_secondary (=auto) oder Liste [min,max]: Bereich der zweiten (rechten) y-Achse. Globale Option.
          
          
           
             
             [Maxima Draw] yrange_secondary (=auto) or list [min,max]: range of the secondary (right) y-axis. Global option.
          
          
           
             yrange_secondary
             yrange_secondary
             :
          
        
      
       
         
           
             
             [Maxima Draw] xtics (=auto): automatische x-Achsmarken, none: keine, Zahl: Schrittweite, Liste mit [min, Schritt, max], oder set() von Zahlen: explizite Vorgabe der Zahlenwerte, oder set() von Listen ["text",pos] mit Vorgabe von Beschriftung und Position. Globale Option.
          
          
           
             
             [Maxima Draw] xtics (=auto): automatic x ticks, none: no x ticks, number: tick interval, list of [min, step, max], or set() of numbers: explicit tick values, or set() of lists ["text",pos] for spec of position and text. Global option
          
          
           
             xtics
             xtics
             :
          
        
      
       
         
           
             
             [Maxima Draw] ytics (=auto): automatische y-Achsmarken, none: keine, Zahl: Schrittweite, Liste mit [min, Schritt, max], oder set() von Zahlen: explizite Vorgabe der Zahlenwerte, oder set() von Listen ["text",pos] mit Vorgabe von Beschriftung und Position. Globale Option.
          
          
           
             
             [Maxima Draw] ytics (=auto): automatic y ticks, none: no y ticks, number: tick interval, list of [min, step, max], or set() of numbers: explicit tick values, or set() of lists ["text",pos] for spec of position and text. Global option. 
          
          
           
             ytics
             ytics
             :
          
        
      
       
         
           
             
             [Maxima Draw] ztics (=auto): automatische z-Achsmarken, none: keine, Zahl: Schrittweite, Liste mit [min, Schritt, max], oder set() von Zahlen: explizite Vorgabe der Zahlenwerte, oder set() von Listen ["text",pos] mit Vorgabe von Beschriftung und Position. Globale Option.
          
          
           
             
             [Maxima Draw] ztics (=auto): automatic z ticks, none: no x ticks, number: tick interval, list of [min, step, max], or set() of numbers: explicit tick values, or set() of lists ["text",pos] for spec of position and text. Global option.
          
          
           
             ztics
             ztics
             :
          
        
      
       
         
           
             
             [Maxima Draw] xtics_secondary (=auto): automatische Marken an der sekundären (oberen) x-Achse, none: keine, Zahl: Schrittweite, Liste mit [min, Schritt, max], oder set() von Zahlen: explizite Vorgabe der Zahlenwerte, oder set() von Listen ["text",pos] mit Vorgabe von Beschriftung und Position. Globale Option.
          
          
           
             
             [Maxima Draw] xtics_secondary (=auto): automatic ticks on the secondary (top) x-axis, none: no ticks, number: tick interval, list of [min, step, max], or set() of numbers: explicit tick values, or set() of lists ["text",pos] for spec of position and text. Global option.
          
          
           
             xtics_secondary
             xtics_secondary
             :
          
        
      
       
         
           
             
             [Maxima Draw] ytics_secondary (=auto): automatische Marken an der sekundären (rechten) y-Achse, none: keine, Zahl: Schrittweite, Liste mit [min, Schritt, max], oder set() von Zahlen: explizite Vorgabe der Zahlenwerte, oder set() von Listen ["text",pos] mit Vorgabe von Beschriftung und Position. Globale Option.
          
          
           
             
             [Maxima Draw] ytics_secondary (=auto): automatic ticks on the secondary (right) y-axis, none: no ticks, number: tick interval, list of [min, step, max], or set() of numbers: explicit tick values, or set() of lists ["text",pos] for spec of position and text. Global option.
          
          
           
             ytics_secondary
             ytics_secondary
             :
          
        
      
       
         
           
             
             [Maxima Draw] xtics_axis (=false): x-Achsmarken am Rand, true: an der Achse. Globale Option.
          
          
           
             
             [Maxima Draw] xtics_axis (=false): ticks on the boundary, true: ticks on the axis. Global option.
          
          
           
             xtics_axis
             xtics_axis
             :
          
        
      
       
         
           
             
             [Maxima Draw] ytics_axis (=false): y-Achsmarken am Rand, true: an der Achse. Globale Option.
          
          
           
             
             [Maxima Draw] ytics_axis (=false): ticks on the boundary, true: ticks on the axis. Global option.
          
          
           
             ytics_axis
             ytics_axis
             :
          
        
      
       
         
           
             
             [Maxima Draw] ztics_axis (=false): z-Achsmarken am Rand, true: an der Achse. Globale Option.
          
          
           
             
             [Maxima Draw] ztics_axis (=false): ticks on the boundary, true: ticks on the axis. Global option.
          
          
           
             ztics_axis
             ztics_axis
             :
          
        
      
       
         
           
             
             [Maxima Draw] xtics_secondary_axis (=false): Marken an der sekundaren (oberen) x-Achse am Rand, true: an der Achse. Globale Option.
          
          
           
             
             [Maxima Draw] xtics_secondary_axis (=false): ticks on the secondary (top) boundary, true: ticks on the axis. Global option.
          
          
           
             xtics_secondary_axis
             xtics_secondary_axis
             :
          
        
      
       
         
           
             
             [Maxima Draw] ytics_secondary_axis (=false): Marken an der sekundaren (rechten) y-Achse am Rand, true: an der Achse. Globale Option.
          
          
           
             
             [Maxima Draw] ytics_secondary_axis (=false): ticks on the secondary (right) boundary, true: ticks on the axis. Global option.
          
          
           
             ytics_secondary_axis
             ytics_secondary_axis
             :
          
        
      
       
         
           
             
             [Maxima Draw] xtics_rotate (=false): x-Achsmarken nicht drehen, true: um 90° drehen. Globale Option.
          
          
           
             
             [Maxima Draw] xtics_rotate (=false): horizontal tick labels, true: vertical tick labels. Global option.
          
          
           
             xtics_rotate
             xtics_rotate
             :
          
        
      
       
         
           
             
             [Maxima Draw] ytics_rotate (=false): y-Achsmarken nicht drehen, true: um 90° drehen. Globale Option.
          
          
           
             
             [Maxima Draw] ytics_rotate (=false): horizontal tick labels, true: vertical tick labels. Global option.
          
          
           
             ytics_rotate
             ytics_rotate
             :
          
        
      
       
         
           
             
             [Maxima Draw] ztics_rotate (=false): z-Achsmarken nicht drehen, true: um 90° drehen. Globale Option.
          
          
           
             
             [Maxima Draw] ztics_rotate (=false): horizontal tick labels, true: vertical tick labels. Global option.
          
          
           
             ztics_rotate
             ztics_rotate
             :
          
        
      
       
         
           
             
             [Maxima Draw] xtics_rotate_secondary (=false): Marken an der sekundären (oberen) x-Achse nicht drehen, true: um 90° drehen. Globale Option.
          
          
           
             
             [Maxima Draw] xtics_rotate_secondary (=false): don't rotate ticks of the secondary (top) x-axis, true: rotate by 90°. Global option.
          
          
           
             xtics_rotate_secondary
             xtics_rotate_secondary
             :
          
        
      
       
         
           
             
             [Maxima Draw] ytics_rotate_secondary (=false): Marken an der sekundären (rechten) y-Achse nicht drehen, true: um 90° drehen. Globale Option.
          
          
           
             
             [Maxima Draw] ytics_rotate_secondary (=false): don't rotate ticks of the secondary (right) y-axis, true: rotate by 90°. Global option
          
          
           
             ytics_rotate_secondary
             ytics_rotate_secondary
             :
          
        
      
       
         
           
             
             [Maxima Draw] xu_grid (=30) Abtastpunkte in x- oder u-Richtung 
          
          
           
             
             [Maxima Draw] xu_grid (=30) sampling points in x- or u-direction 
          
          
           
             xu_grid
             xu_grid
             :
          
        
      
       
         
           
             
             [Maxima Draw] yv_grid (=30) Abtastpunkte in y- oder v-Richtung 
          
          
           
             
             [Maxima Draw] yv_grid (=30) sampling points in y- or v-direction 
          
          
           
             yv_grid
             yv_grid
             :
          
        
      
       
         
           
             
             [Maxima Draw3D] xyplane (=false): xy-Koordinatenebene automatisch anordnen, Zahl: z-Koordinate. Globale Option.
          
          
           
             
             [Maxima Draw3D] xyplane (=false): automatic allocation of the xy-plane, real number: xy-plane intersects the z-axis at this level. Global option.
          
          
           
             xyplane
             xyplane
             :
          
        
      
       
         
           
           Objekte 
        
        
      
       
         
           
             
             [Maxima Draw2D] bars(b1,b2...) Säulendiagramm, Säulen gegeben durch Listen (x,h,w). Optionen: key, color, fill_color, fill_density und line_width.
          
          
           
             
             [Maxima Draw2D] bars(b1,b2...) vertical bars, given as lists [x,h,w]. Options: key, color, fill_color, fill_density and line_width.
          
          
           
             _
             bars
             _
             bars
             :
          
        
      
       
         
           
             
             [Maxima Draw3D] elevation_grid(Matrix,x0,y0,w,h) Stellt eine Matrix in 3D dar. M_11 bei x=x0,y=y0+h, M_mn bei x=x0+w,y=y0. Optionen:  xu_grid, yv_grid, line_type, key, wired_surface, enhanced3d und color
          
          
           
             
             [Maxima Draw3D] elevation_grid(matrix,x0,y0,w,h) Draws a m x n-matrix in 3D. M_11 at x=x0,y=y0+h, M_mn at x=x0+w,y=y0. Options:  xu_grid, yv_grid, line_type, key, wired_surface, enhanced3d and color
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             _4
             _5
             elevation_grid
             _1
             _2
             _3
             _4
             _5
             elevation_grid
             :
          
        
      
       
         
           
             
             [Maxima Draw3D] elevation_grid(Matrix,x0,y0,w,h) Stellt eine Matrix in 3D dar. M_11 bei x=x0,y=y0+h, M_mn bei x=x0+w,y=y0. Optionen:  xu_grid, yv_grid, line_type, key, wired_surface, enhanced3d and color
          
          
           
             
             [Maxima Draw3D] cylindrical(r(φ,z),z,zmin,zmax,φ,φmin,φmax) Draws a function in cylindrical coordinates. Options: xu_grid, yv_grid, line_type, key, wired_surface, enhanced3d and color.
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             cylindrical
             _1
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             _5
             _6
             _7
             cylindrical
             :
          
        
      
       
         
           
             
             [Maxima Draw2D] ellipse(xc,yc,a,b,φ1,φ2) Ellipse, zentriert bei xc, yc mit den Halbachsen a und b, von Startwinkel φ1 und Winkelbreite dφ. In Maxima 5.47 wird die Breite doppelt gezählt. Optionen nticks, transparent, fill_color, border, line_width, line_type, key und color. 
          
          
           
             
             [Maxima Draw2D] ellipse(xc,yc,a,b,φ1,dφ) plots an ellipse centered at [xc, yc] with horizontal and vertical semi axis a and b, respectively, starting at φ1 with an amplitude dφ. Note that in Maxima 5.47 the amplitude is doubled. Options: nticks, transparent, fill_color, border, line_width, line_type, key and color. 
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             #3
             #4
             #5
             #6
             ellipse
             #1
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             #3
             #4
             #5
             #6
             ellipse
             :
          
        
      
       
         
           
             
             [Maxima Draw2D] errors(e1,e2...) Punkte mit Fehlerbalken, horizontal, vertical oder beide, abhängig von der Option error_type. Argumente für error_type = x: Listen [x, y, xdelta] oder [x, y, xlow, xhigh]. Argumente für error_type = y; Listen [x, y, ydelta] oder [x, y, ylow, yhigh]. Argumente für error_type = xy oder error_type = boxes: Listen [x, y, xdelta, ydelta] oder [x, y, xlow, xhigh, ylow, yhigh]. Optionen: error_type, points_joined, line_width, key, line_type, color, fill_density, xaxis_secondary, and yaxis_secondary 
          
          
           
             
             [Maxima Draw2D] errors(e1,e2...) Draws points with error bars, horizontally, vertically or both, depending on the value of option error_type. If error_type = x, arguments are lists [x, y, xdelta] or [x, y, xlow, xhigh]. If error_type = y, arguments are lists [x, y, ydelta] or [x, y, ylow, yhigh]. If error_type = xy or error_type = boxes, arguments are lists [x, y, xdelta, ydelta] or [x, y, xlow, xhigh, ylow, yhigh]. Options: error_type, points_joined, line_width, key, line_type, color, fill_density
          
          
           
             _
             errors
             _
             errors
             :
          
        
      
       
         
           
             
             [Maxima Draw2D] explicit(f,x,xmin,xmax) zeichnet eine Funktion f von x von xmin bis xmax. Optionen: nticks, adapt_depth, draw_realpart, line_width, line_type, key, filled_func, fill_color und color
          
          
           
             
             [Maxima Draw2D] explicit(f,x,xmin,xmax) plots explicit function f, with variable x taking values from xmin to xmax. Options: nticks, adapt_depth, draw_realpart, line_width, line_type, key, filled_func, fill_color and color
          
          
           
             _1
             _2
             _3
             _4
             explicit
             _1
             _2
             _3
             _4
             explicit
             :
          
        
      
       
         
           
             
             [Maxima Draw3D] explicit(f,x,xmin,xmax,y,ymin,ymax) zeichnet eine Funktion f von x und y im Bereich xmin bis xmax und ymin bis ymax Optionen: draw_realpart, xu_grid, yv_grid, line_type, line_width, key, wired_surface, enhanced3d und color. 
          
          
           
             
             [Maxima Draw3D] explicit(f,x,xmin,xmax,y,ymin,ymax) plots the explicit function f, with variable x taking values from xmin to xmax and variable y taking values from ymin to ymax. Options: draw_realpart, xu_grid, yv_grid, line_type, line_width, key, wired_surface, enhanced3d, and color. 
          
          
           
             #1
             #2
             #3
             #4
             #5
             #6
             #7
             explicit
             #1
             #2
             #3
             #4
             #5
             #6
             #7
             explicit
             :
          
        
      
       
         
           
             
             [Maxima Draw2D] image(Matrix,x0,y0,w,h)  Farbdarstellung einer m x n Matrix entsprechend der Option palette im Gebiet (x0,y0) bis (x0+w,y0+h)
          
          
           
             
             [Maxima Draw2D] image(matrix,x0,y0,w,h)  plots matrix in the rectangular region from vertex (x0,y0) to (x0+w,y0+h) according to global option palette.
          
          
           
             #1
             #2
             #3
             #4
             #5
             image
             #1
             #2
             #3
             #4
             #5
             image
             :
          
        
      
       
         
           
             
             [Maxima Draw2D] implicit(f,x,xmin,xmax,y,ymin,ymax) 2D Darstellung einer implizit gegebenen Funktion im angegebenen Variablenbereich (marching squares Algorithmus). Optionen: ip_grid, ip_grid_in, line_width, line_type, key, color
          
          
           
             
             [Maxima Draw2D] implicit(f,x,xmin,xmax,y,ymin,ymax) plots the implicit function defined by f, with variable x taking values from xmin to xmax, and variable y taking values from ymin to ymax. Options: ip_grid, ip_grid_in, line_width, line_type, key, color
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             #3
             #4
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             #6
             #7
             implicit
             #1
             #2
             #3
             #4
             #5
             #6
             #7
             implicit
             :
          
        
      
       
         
           
             
             [Maxima Draw3D] implicit(f,x,xmin,xmax,y,ymin,ymax,z,zmin,zmax) 3D Darstellung einer implizit gegebenen Funktion im angegebenen Variablenbereich (Marching Cubes Algorithmus). Optionen: x_voxel, y_voxel, z_voxel, ip_grid_in, line_width, line_type, wired_surface, enhanced3D, color [Maxima Draw]
          
          
           
             
             [Maxima Draw3D] implicit(f,x,xmin,xmax,y,ymin,ymax,z,zmin,zmax) plots the implicit surface defined by f, with variable x taking values from xmin to xmax, variable y taking values from ymin to ymax and variable z taking values from zmin to zmax. This object implements the marching cubes algorithm. Options: x_voxel, y_voxel, z_voxel, line_width, line_type, key, wired_surface, enhanced3d,and color
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             #2
             #3
             #4
             #5
             #6
             #7
             #8
             #9
             #10
             implicit
             #1
             #2
             #3
             #4
             #5
             #6
             #7
             #8
             #9
             #10
             implicit
             :
          
        
      
       
         
           
             
             [Maxima Draw2D and 3D] label(list) Beschriftung, im 2D gegeben als Liste (text,x,y), im 3D als Liste (text,x,y,z), spezielle Optionen: color, label_alignment, label_orientation
          
          
           
             
             [Maxima Draw2D and 3D] label(list) text label specified in 2D as list [text,x,y], in 3D as list [text,x,y,z], Options: color, label_alignment, label_orientation
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             label
             _
             label
             :
          
        
      
       
         
           
             
             [Maxima Draw2D] parametric(fx,fy,p,pmin,pmax) parametrisch gegebenen Funktion. Optionen: nticks, line_width, line_type, key, color, enhanced3d
          
          
           
             
             [Maxima Draw2D] parametric(fx,fy,p,pmin,pmax) plots the parametric function fx, fy  with parameter p taking values from pmin to pmax. Options: nticks, line_width, line_type, key, color, enhanced3d
          
          
           
             #1
             #2
             #3
             #4
             #5
             parametric
             #1
             #2
             #3
             #4
             #5
             parametric
             :
          
        
      
       
         
           
             
             [Maxima Draw3D] parametric(fx,fy,fz,p,pmin,pmax) Parametrische Funktion, beschrieben durch drei Koordinatenfunktionen des Parameters p im gegebenen Bereich von pmin bis pmax. Optionen: nticks, line_width, line_type, key, color, enhanced3d
          
          
           
             
             [Maxima Draw3D] parametric(fx,fy,fz,p,pmin,pmax) parametric function, described by three coordinate functions of parameter p, taking values from pmin to pmax. Options: nticks, line_width, line_type, key, color, enhanced3d
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             #2
             #3
             #4
             #5
             #6
             parametric
             #1
             #2
             #3
             #4
             #5
             #6
             parametric
             :
          
        
      
       
         
           
             
             points(matrix) Punkte, 2D: n x 2 oder 2 x n -> n Punkte bei (x,y) oder 1 x n oder n x 1 -> n Punkte bei (index,y). 3D: n x 3 oder 3 x n -> Punkte bei (x,y,z). Spezielle Optionen: points_joined, point_type, point_size [Maxima Draw2D/3D] 
          
          
           
             
             [Maxima Draw2D and 3D] points(matrix) 2D: n x 2 or 2 x n -> n points at (x,y) or 1 x n or n x 1 -> n points at (index,y). 3D: n x 3 or 3 x n -> points at (x,y,z). Specific options: points_joined, point_type, point_size, enhanded
          
          
           
             #1
             points
             #1
             points
             :
          
        
      
       
         
           
             
             [Maxima Draw2D] points(lx,ly) Punkte, gegeben durch zwei Listen der x- und y-Koordinaten. Spezielle Optionen: points_joined, point_type, point_size [Maxima Draw2D] 
          
          
           
             
             [Maxima Draw2D] points(lx,ly) points given by two lists, special options: points_joined, point_type, point_size
          
          
           
             #1
             #2
             points
             #1
             #2
             points
             :
          
        
      
       
         
           
             
             [Maxima Draw3D] points(lx,ly,lz) zeichnet Punkte, gegeben durch drei Listen, spezielle Optionen: points_joined, point_type, point_size
          
          
           
             
             [Maxima Draw3D] points(lx,ly,lz) points given by three lists, pecial options: points_joined, point_type, point_size
          
          
           
             #1
             #2
             #3
             points
             #1
             #2
             #3
             points
             :
          
        
      
       
         
           
             
             [Maxima Draw2D] polar(r,φ,φmin,φmax) zeichnet Funktionen, die in Polarkoordinaten gegeben sind (Radius r als Funktion des Winkels φ). Spezielle Optionen: key, nticks, line_width, line_type, color
          
          
           
             
             [Maxima Draw2D] polar(r,φ,φmin,φmax) draws functions given in polar co-ordinates (radius r as function of angle φ). Special options: key, nticks, line_width, line_type, color
          
          
           
             #1
             #2
             #3
             #4
             polar
             #1
             #2
             #3
             #4
             polar
             :
          
        
      
       
         
           
             
             [Maxima Draw2D] polygon(matrix)  Polygon durch die als n x 2 Matrix gegebenen Punkte. Spezielle Optionen: transparent, fill_color, border, line_width, key, line_type color 
          
          
           
             
             [Maxima Draw2D] polygon(matrix)  polygon defined by matrix (each row one point). Special options: transparent, fill_color, border, line_width, key, line_type color 
          
          
           
             #1
             polygon
             #1
             polygon
             :
          
        
      
       
         
           
             
             [Maxima Draw2D]  polygon(lx,ly)  Zeichnet ein Polygon durch die als x- und y-Listen gegebenen Punkte. Spezielle Optionen: transparent, fill_color, border, line_width, key, line_type color 
          
          
           
             
             [Maxima Draw2D]  polygon(lx,ly)  polygon defined by two lists. Special options: transparent, fill_color, border, line_width, key, line_type, color 
          
          
           
             #1
             #2
             polygon
             #1
             #2
             polygon
             :
          
        
      
       
         
           
             
             [Maxima Draw2D/3D] quadrilateral(l1,l2,l3,l4) Viereck, gegeben durch Listen der Eckkoordinaten 2D: [x,y] oder 3D: [x,y,z]. Spezielle Optionen: transparent, fill_color, border, line_width, key, line_type, color, enhanced3D (nur 3D)
          
          
           
             
             [Maxima Draw2D/3D] quadrilateral(l1,l2,l3,l4) quadrilateral given by lists  of vertex coordinates: [x,y] in 2D or [x,y,z] in 3D. Special options: transparent, fill_color, border, line_width, key, line_type, color, enhanced3D (3D only)
          
          
           
             #1
             #2
             #3
             #4
             quadrilateral
             #1
             #2
             #3
             #4
             quadrilateral
             :
          
        
      
       
         
           
             
             [Maxima Draw2D] rectangle(l1,l2) Rechteck gegeben durch Koordinatenlisten [x,y] gegenüberliegender Ecken. Spezielle Optionen: transparent, fill_color, border, line_width, key, line_type, color 
          
          
           
             
             [Maxima Draw2D] rectangle(l1,l2) specified by lists [x,y] of opposite corners. Special options: transparent, fill_color, border, line_width, key, line_type, color 
          
          
           
             #1
             #2
             rectangle
             #1
             #2
             rectangle
             :
          
        
      
       
         
           
             
             [Maxima Draw2D] region(expr,x,xmin,xmax,y,ymin,ymax) Füllt das Gebiet wo expr wahr (true) ist im Bereich von xmin, xmax, ymin, ymax. Optionen: fill_color, key, x_voxel, y_voxel
          
          
           
             
             [Maxima Draw2D] region(expr,x,xmin,xmax,y,ymin,ymax) Fills the region where expr is true in the domain given by xmin, xmax, ymin, ymax. Options: fill_color, key, x_voxel, y_voxel
          
          
           
             #1
             #2
             #3
             #4
             #5
             #6
             #7
             region
             #1
             #2
             #3
             #4
             #5
             #6
             #7
             region
             :
          
        
      
       
         
           
             
             [Maxima Draw2D] region(expr,x,xmin,xmax,y,ymin,ymax) Füllt das Gebiet wo expr wahr (true) ist im Bereich von xmin, xmax, ymin, ymax. Optionen: fill_color, key, x_voxel, y_voxel
          
          
           
             
             [Maxima Draw3D] spherical(r, a, mina, maxa, z, minz, maxz) plots function r(a, z) defined in spherical coordinates, with azimuth a taking values from mina to maxa and zenith z taking values from minz to maxz. Options: xu_grid, yv_grid, line_type, key, wired_surface, enhanced3d, and color.
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             spherical
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             spherical
             :
          
        
      
       
         
           
             
             [Maxima Draw2D/3D] triangle(l1,l2,l3)  Dreieck, gegeben durch Koordinatenlisten [x,y] (2D) oder [x,y,z] (3D) der Ecken. Spezielle Optionen: transparent, fill_color, border, line_width, key, line_type, color 
          
          
           
             
             [Maxima Draw2D/3D] triangle(l1,l2,l3)  given by co-ordinate lists [x,y] (2D) or [x,y,z] (3D) of the corners.Options: transparent, fill_color, border, line_width, key, line_type, color 
          
          
           
             #1
             #2
             #3
             triangle
             #1
             #2
             #3
             triangle
             :
          
        
      
       
         
           
             
             [Maxima Draw3D]  tube(fx,fy,fz,fr,p,pmin,pmax)  Röhre, gegeben durch Mittellinie mit fx,fy,fz und den Radius fr als Funktionen des Parameters p. Spezielle Optionen:  xu_grid, yv_grid, line_type, line_width, key, wired_surface, enhanced3d, color, capping.
          
          
           
             
             [Maxima Draw3D]  tube(fx,fy,fz,fr,p,pmin,pmax)  tube, given by functions fx,fy,fz of the centerline and radius function fr of the parameter p from pmin to pmax. Special options:  xu_grid, yv_grid, line_type, line_width, key, wired_surface, enhanced3d, color, capping.
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             #3
             #4
             #5
             #6
             #7
             tube
             #1
             #2
             #3
             #4
             #5
             #6
             #7
             tube
             :
          
        
      
       
         
           
             
             [Maxima Draw2D/3D]  vector(l1,l2)  Pfeil,  gegeben durch Koordinatenlisten (x,y) (2D) oder (x,y,z) (3D) der Endpunkte. Spezielle Optionen:  head_both, head_length, head_angle, head_type, line_width, line_type, key color.
          
          
           
             
             [Maxima Draw2D/3D]  vector(l1,l2)  given by co-ordinate lists [x,y] (2D) or [x,y,z] (3D) of the end points. Spezielle Optionen:  head_both, head_length, head_angle, head_type, line_width, line_type, key color.
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             vector
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             [Maxima]  set(e1, e2,...) Maxima set (Liste in geschweiften Klammern)
          
          
           
             
             [Maxima]  set(e1, e2,...) Maxima set (in Maxima this is a list in curly braces)
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             set
             :
          
        
      
       
         
           
             
             [Maxima] args(expr) Liste der Argumente von expr 
          
          
           
             
             [Maxima] args(expr) list of the top level arguments of expr. Extracts lines from matrices.
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             args
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             args
             :
          
        
      
       
         
           
             
             [Maxima] apply(f, Liste) Macht die Elemente der Liste zu Argumenten von f. apply(f,args(matrix)) wandelt eine Matrix in Argumente einer Funktion um -> f(row1, row2,...) 
          
          
           
             
             [Maxima] apply(f, list) applies the elements of list as arguments to f. apply(f,args(matrix)) converts a matrix into arguments of a function -> f(row1, row2,...)
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CHAPTER 6. CURVE FITTING

6.1 Fit of a Cubic Parabola to 5 Random Points

A cubic parabola f(z) = az® + bx? + cx + d is to be fitted to five points with z; = 1...5
and y; being random values between 0 and 1.

First, the data matrix is created by combining the vectors with the z-values and the y-
values. Then, the model function f(z) is defined. The free parameters must be undefined
variables. If in doubt, apply the function Clear () to the parameters.

D := augment [[1..5];Randnm[5]] 10,4681
2 0,736

Clear(a;b;c;d)=1
p=|3 0,406
i ) 10,849
flx)=a-x +b-x +c-x+d 5 0,845

Now the Fit() function is applied. Display the result with Context menu> Optimiza-
tion> None. Otherwise the results aren’t displayed properly.

Data and model parameters and optimized
column names initial guess parameter values
& 1, a=0,0130807T6422217354
I X E 3, b=-0,10245656098800907
F=Fit D; ;y:fl{:{]; ; =
v e |1, c=0,3052002065823547
d 1, d=0,28204033830591464

Context menu= Optimization= MNone
Assign() is used to convert the equations from Fit () into parameter assignments. Thus
the model function can be plotted using the result of the fit.

The quality of the fit is evaluated by the model-data-deviations (residuals) and by the
mean square error (MSE). These functions take the same arguments like Fit ().

0,0131 3
—0,1025
Bssign(F)= ) 15
0,3052 ! : _T____,f'”/
9.282 »~ 05fF 4§
Quality of the fit 0
= 05 F
R :=Residuals |D; ;y=£(x) 1 | . . L )
ul o 1 2 3 4 5 6
-0,0371
x
0,149
R=| —0,223 Explicit(f{:{};:-:; o: E:{
0 color = red
. 149 - abo
-0,0371 Draw2D |spoints (D) :
1&0
-1
p rangeg =—
MSE D;{ ;y:f(x]]=ﬂ,0193 yang {2
¥
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CHAPTER 6. CURVE FITTING

6.2 Fit of a Circle to 4 Points

Find a circle with center point z,,y. and radius R such that it is an optimal fit to four
given points.

The circle is represented by an implicit equation f(x,y) = 0. The involved variables are
cleared, just to be sure they are undefined.

oo Clear{:{c;yc;ﬂ;:{;y}=l

Flx: _V]I:[x—xg]z—[y—yclz—ﬁz

There is no solution such that all points are on the perimeter of the circle, so an approxi-
mate solution is to be found. The function Fit () is used to determine the parameters of
the circle such that the mean square error of f(x,y) = 0 at the data points is minimized.

X
o

x_=0,29924286819971646
— 4 X —
F:=Fit |D; y;f{x;y]-ﬂ; Y. i

=<y =1,93378108438053E63
=3

| I

R E=1,53087e602322017

Context menu> Optimization= Mone

The resulting equations are converted to assignments. In the plot the implicit equation
is used directly. Center and data points are added to the plot.

0,289
d ¥ =0,289 vy =1,83 R=1,099
Assign(F)=41,93 = i
1,99
implicit[f(x;y];x;—ﬂ;ﬂ;y;—l;5} 5
points [[—‘fc ¥, ]] 4r
3t f’fr
cmd =4 color = red - )
point type =circle ik k
points (D) 0 -
prspﬂrtisnal_axes =XV R L
3 -2 410
X
170
DrawzZD | cmd ;
1&0

For an exact solution, the function f(z,y) should be zero at the data points. The deviation
is shown using Residuals (). This isn’t the real distance between points and perimeter
but it is approximately proportional to it.

—0,1345 f'D : D ]:-—0,1345
0,267 11 12

—0,1991

0, 0658

x
RBesiduals D;{ ;f(x;y]:[!l =
¥
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CHAPTER 6. CURVE FITTING

6.3 Fit of Piecewise Continuous Functions

This example is based on a forum discussion, there you can find files containing the data.
The key is to use the function charfun(), which is undefined in SMath. In Maxima, it
converts boolean expressions to 0 or 1 for use in arithmetics and plotting.

In the example, the model for the data consists of two functions f;(z < xy) and fo(z > x0).

0,0265 1016 Clear{al;bl; Ty ag;bz; cz]=1
0,0778 1014 ! !
0,1291 1002| £, (x)=c, +b, x+a, x f(x)=c,+by, x+a, x
0,1804 996
0,2317 970 £ (x):=charfun [x ixﬂ}-fi (% )+ charfun [x }:{ﬂ]-fj (=)
0,283 906
0,3343 B93 | Xx,°=0,33 |ral
0,3E56 EBT5 A [1
0,4369 850 s
0,4882 779 | X 1|1 -5
F:=Fitc|D; ;y=f|[:-{];< =e¢ =10
.| 0,5395 775 ¥ a,” |1
" |0,5008 726 A 1
0,6421 706 ? |1
0,6934 675 | =z
0, 7447 661
X
0,796 &47 | MSE D;{Y;y=f[x];F]=??,5
0,8473 611
0,B8986 591
0,9499 588 1000 F
1,0012 575 850
1,0525 558 00 |-
1,1038 553 |
L+ ] 800 |-
=29
750
700 -
850 |-
800 |-
B850 k= I ] 1 1 -
0 02 04 06 08B 1 1.2
x
explicit |£|x P E:0;1,2 300
Drawl2D il [ j‘F i ;{ZDD
points (D)

Remarks:

e We don'’t use Assign() here, instead we use the return value F of Fit () directly as
argument of MSE() to evaluate the mean square error. In the graph, the result is
applied using the local substitution function at ().

e It would be desirable to also let Fit() find the best value for zy. This fails, because
the derivative of the target function (mean square error) is zero (between data
points) or undefined (discontinuity at data points). Changes of xy only result in
changes of the fit, if data points change the function, they are fit to, i.e. if the sign
of x; — xg changes for any 1.
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CHAPTER 6. CURVE FITTING

e Probably you also want to have a continuous and smooth model. In this case, you
can enforce constraints fi(xo) = fa(zo) and f;(z¢) = fo(xo) using Solve().
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7 Algebraic Equations

Contents
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=ﬁ Solve.sm

The function Solve() is an interface to Maxima’s solve () function. It’s advantages are:
e Symbolic solution of linear and non-linear systems of equations.
e No need for initial guesses or search intervals.
e Simple handling of multiple solutions.
e The function can handle units of measurement.

Sometimes the symbolic expressions become too complex and Solve() doesn’t find a
solution. Then you can try the native SMath solver solve() or roots() or the function
FindRoot () from the Nonlinear Solvers Plugin.

Solve(eqn,vars)

eqn equation or list or vector of equations. If the expressions don’t contain a
Boolean equal sign, then implicitly = 0 is added.

vars variable or list or vector of variables to solve for.

The solution comes as an equation or a list of equations name=value. If there is more
then one solution, these are given as Matrix of equations or lists of equations.

The solution can be converted into assignments using the function Assign(). In case of
multiple solutions you need to decide, which one to use for assignment. Select the solution
by using the appropriate element index with the solution matrix.

Note: Always use symbolic — or even better, no — optimization/evaluation for results
display. The equations contain undefined variables and those can’t be displayed with
numeric optimization.
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CHAPTER 7. ALGEBRAIC EQUATIONS

7.1 Scalar Equations

Single Solution

Single equations and variables can be specified as scalar expressions without using lists
or matrices.

v —b

Solve (a-x+b=y:a|=a=
x

In the case of a single solution the result is a single equation without any wrapping
structure. To actually assign the solution to the variable, use Assign():

L:==Sclve|a-x+b=y:a) L=a=y_h

X
y—kb ¥y—k

Assign (L )=
X ®

Alternatively, you can use the substitution function at() from the Custom Functions
plugin.

Clear[a]=1

a:at [Tab] a [=]x

Multiple Solutions

Multiple solutions for a single variable are displayed as a list of equations. You can select
one of them by using an element index.

Clear (x; y)=1 explicit (£(x); x; —1; 5)
f{X)::xa-g-xz._S.K - explicit (15; x; —1; 5)
=5
L :=5alve [fl[x =15;:-£] Yraﬂﬂ'5={zu
x=—i-£
L=sx=i-5 20 /
15
x=3
10 | /
=
3F -
]
_5 1 1 L 1
-1 0 1 2 3 4 5
x
220
Draw2D | 150]

While solving and selecting solutions, the variables must be undefined. Delete eventual
values using Clear ().
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CHAPTER 7. ALGEBRAIC EQUATIONS

Rssign[l’. ]=—:‘.- 5 X=-2,24-1 Clear(x)=1
1

Essign[LEJZj_-.,n'E ®¥=2,24-1 Clear(x)=1

Essign[l. 3)=3 =3 Clear (x)=1
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CHAPTER 7. ALGEBRAIC EQUATIONS

7.2 Systems of Equations

Single Solution

Systems of equations are given as vectors or lists. Also the variables are given as vectors
or lists. In the case of a single solution, it is returned as a list of equations, one for each
variable.

Clear(a)=1

I-x+4-y=7 x —52+7-a
L :=5aglve F =t
2-X+a-y=13 ¥ L= —8+3-a
— 25
—E+3-a

Assign() converts all equations in the argument (no matter what structure that is) to
assignments.

—52+7-3
. -8+3-a _—524+7-a B 25
Assign(L)= 2= T Te+3a ¥ "et3a
—8+3-a

The variant with at () does not work out of the box, because L doesn’t actually store the
result but rather the command to create it.

at () expects equations as specification for substitution.

Clear (x; y)=1

X
¥

X
¥

"Cannot parse.
lastError = [Z] unknowns: x, ¥
[1] walues: Sclve (mat (3*x+4*y=7,2*x+a*y=13,2,1) , mat (X, v,2,1))."

If the expression is converted to displayed form (this is what the function simp() does),
then at () can handle the assignment.

simp (a#):= |3tr2num|{numzstr (2#))

—L52+7-2

= x] % —8—-3-a
¥ ¥ . —

simp (L) ¥ 25

—8T3-a

Multiple Solutions

Here we show how to build the system of equations one by one. This can be useful if you
want to explain the meaning of these equations separately.

Note that assigning an equation to a variable requires brackets around the equation. The
assignment operator := has higher priority than the Boolean equal.
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CHAPTER 7. ALGEBRAIC EQUATIONS

The plot shows that there are two solutions:

&1 [ 2L g? z] G1 (3 1)
=X T - = KTy =
1 ¥ 2
implicit[Gl l;x;—a;a;y;—z;z]
2 Y
color = red 1"3‘ L :
P =4 4— \
mmplicit |G1 ;x; —3;3;¥v: —2; 2 0.5 -
2 = 0
: al 0.5 4
proportl ﬂnal_a:{es =Xy L
1.5
_g 1 1 IIII'( i
-2 49 0 01 2 3
%
&1 [2' 2 2] G1 (3-x+ 1)
=X -T- — = K+ ¥ =
1 ¥ 2
X -3+ -+
L:=Solve |&1; g 1. i | . .t
¥ L= 10 10
Y_l—-—a-...n'lﬂ Y__—l—-—B-,.,.llﬁ
10 10

Multiple solutions with multiple variables are returned as a row vector of lists. The
solutions can be accessed via an element index.

-3+ 19
—— x__—af,,flg y_lfa-,.flg
Assign[l’. }: 10 10
1 1+3-419
10 K=—|:|,-135 Y=1,4|:|E Clear[:{;y}:l
3+.J19 x_af,.,"ls __—:Lf3-,a'19
10 10 10
Rssign[l. ]=
4 _z1+3-419 3 —gp,736 y=-1,208
10

Clear(x; y)=1
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8 Ordinary Differential Equations

Contents
8.1 Function ODE.2() . . . . . . . . . ..o 88
8.2 atvalue() and desolve() . . . . . . . . . ... 89

=i ODE2.sm

Maxima has many features for ordinary differential equations (ODE). Some of them are:
e The function ODE.2() for symbolic solution of ODE up to second order.

e The plot functions for direction fields in the Maxima package drawdyf.
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CHAPTER 8. ORDINARY DIFFERENTIAL EQUATIONS

8.1 Function 0DE.2()

The function ODE.2() solves ordinary differential equations up to second order.
ODE.2(ode;f(t),t)

ode differential equation

f(t) unknown function

t independent variable

The result is a Boolean equation which can be used by Assign() for assignment.
Depending on the order of the ODE, the solution contains one or two integration
constants, named c (first order) or k1 and k2 (second order).

This is demonstrated for the initial value problem

d2
de?

w(t) +ww(t) =0, w(0)=1, iw(zﬁ)

=0
dt

t=0

First, the general solution is obtained:

2

L:=0DE,
d t
"a is mssumed to be positive."

¥ (t)=kl-sin(t -w)+k2-cos(t-w

V(t]—mz-br[t:l=l:l;w[t}; tl

IL =

The message “w is assumed to be positive” means that Maxima internally asked for the
sign of w. The plugin captures such questions and always responds with +. The message
is integrated in the result for transparency. This way the user can see that the assumption
was made.

The user can store such assumptions in advance and thus avoid questions by Maxima.
ﬂ[assme (@ >=0))=4{a>0

2
2

L:= C-'DEE,

v(t)+e -w(t)=0:w(t):t
d t

L=v(t)=kil-sin(t-w)+k2 cos(t-a)

The return value is a Boolean equation. Using Assign() this equation can be converted
into a definition of the unknown function. The solution contains one or two constants of
integration depending on the order of the ODE. Their name is ¢ (first order) or k1 and
k2 (second order).

Bssign(L)=ki-3in(t-o)+ k2 -cos(t-a)

V{t]=kl-sin(t-m]—k2-cusl{t-ca]

The constants are determined from the initial conditions w(0) = 1 and w'(0) = 0. Note
that you can’t write the latter as dw(0)/dt because w(0) isn’t a function of ¢ any more.
Thus the derivative yields zero. Therefore, the derivative has to be computed first and
then the value t = 0 has to be substituted using at ().
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v{t}=hi-sin[t-m]—1scos{t-m]

In order to plot the solution, w must be given a value.

=1
explicit [v(t]; t;0;40] 15
1q p /\ p
}rlab=l—" (£) "™ 05
1,5 ¥ 0
yrange =q, 05 - \/ \} / |
K \_}
1.5 '
0 30 35 40
t
Drawz2D

300
B
{150]

8.2 atvalue() and desolve()

The combination of the Maxima functions atvalue() and desolve() is an alternative to
ODE.2() and Solve() for the solution of initial value problems.

The initial values are specified in the format (function, time, value). The problem can be
specified as a system of equations involving multiple functions of the independent variable.
It is not required to combine them into a single differential equation.

In the following example, the equations are collected into a list using a Mathcad block
from the Mathcad Tools plugin (Insert> Mathcad Block). The Mathcad block collects
it’s contents from a resizable region on the sheet. It is always a good idea to verify the
content of the collection.
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Store the initial conditions
[:"E[atvalue {Uc[t]; t=0; UC’G]]Z Ug. g QE[atvaiue (1(t); £=0; n]] =0

Define the system of differential equations

U.(t)]=R-I(t) Constitutive U, (t)=R-I(t)
laws for
d resistor, 4
=L -—— . : o |lt|=L-——TI|t
Uﬂ[t] L dtI(t] inductor and T Ll{ ) dt (t)
d capacitor ORE =+ d
I(t)l=Cc-—U_ [t =c.2
(t)=c 2o (¢) r(t)=c 2o, (t)
U, (t)+ U, (£)+0, (¢)=0  Kirchhoffs law U (t)+ U (E)+ U, (£)=0
E}DE

The solution is obtained using desolve(). The arguments are the system of equations
and a list of functions for which to solve. This list must include all functions in the
system. In the following screenshot the return value of desolve() has been converted
into assignments.

I(t)
u. ()
| A c
5in:=RAs=ign F_:E' desclve | ODE : UL[t]
g ()
_'[ 2
. C-|C-R —4-LJ -t
2-C-0O -zinh
c.0 2-C-L
I(t)=- R-t
2-L
e -YyC-|{C-BR —4-L
’J‘ 2 4 2
. C-|C-BE —4-L|-tL cC-lC-R —4-L |-t
UCE- C -R-s3inh + cosh C-R —4-
+—E- 2:C-L 2-C-L
0, ()= -
2-1I
e -“J‘C-[C-R —4-L]
,J ) ,J 5 )
) C-|C-E —4-L])-t C-\C-BR —4-L)-¢L Z
1) -| € -R-3sinh —cosh Y-\ —4-
| et 2-¢c-L 2-C-L
UL[t]_ Rt |
2-L
e -‘]‘C-[C-R —4-L]
de-fcr?-sz)
L C-l\1C-R —4-LJ -t
2-C-R-U. ,-3inh
4 - 2-C-L
Up (£)=~

R-E

2-L 2 '
e -‘\l/a:-[c-ﬂ —4-L]

If values are assigned to the variables, a plot can be generated:
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Capacitor C:=1nF
Inductivity L :=pH
Resistor R:=5@
Initial condition forcapacitor voltage 0. =10V
Initial current I,=10V
10 0.4
U
U, -1 0.2
Up W 1 0.2
I —
> 101 Z
= 1 -0.1 O
< -0.2
1 -0.3
_10 1 1 1 1 _0_4
0 0.2 0.4 0.6 0.8 1
Time (us)
fed func =10
fill_c-r:llﬂr ="§ffO00008BE™
ksy="0U C"
explicit [Uc[t us); t; 0; 1]
fill_calﬂr ="§ffffO08E"™
key="0 L"
explicit [UL (t us); £;0; 1]
fi_T._T._Cﬂ_T.ﬂr ="$0000f£BE™
key="0O R"
‘Expllﬂlt [UR {t ].1.3]; E;0; 1]
vitics =5
yaxis_secandar}r = Lrue
¥label secondary ="Current I (&))"
vtics secondary =0,1
filled func =falses
color =black
key — "I"
sxplicit (I(tus); t;0;1)
—0,4
¥range secondary =
— 0,4
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9.1 Custom Definitions and Translations

Custom definitions and translations are stored in the config file mazima.zml, which resides
in the top level maxima plugin directory. If the Development tools plugin is installed,
then you can open the plugin directory via Insert™> Development Tools> Plugin’s
folder> MaximaPlugin.

Note that such configurations are local to your SMath installation. Documents which
make use of such features aren’t portable, i.e. they won’t work on other computers. Yet
it enables you to experiment with translations without access to the source code.

Example

Let’s assume we want to add handling of the SMath function round(x,n) which is not
available in Maxima. In Maxima, we have just round(x), which rounds to zero decimal
places.

First, we have to define a helper function in Maxima, to which we later translate round (x,n):
round2(x,n) :=round (x*10°n)/10"n$
We add this definition to mazima.xml:

<CustomlLoadCommands>
<Command>round2(x,n) :=round (x*10~n) /10"n$</Command>
</CustomLoadCommands>

Second, we need to add translation rules to map round(x,n) to round2(x,n):

<ConvertFromSMathToMaxima>
<Expression regex="round\(" replace="round2("></Expression>
</ConvertFromSMathToMaxima>

As it may happen that a symbolic expression returned from Maxima contains round (x),
we also want to add a translation into the SMath equivalent round(x,0). This is a bit
more involved, as we have to isolate the argument of round(), in order to add a second
one:

<ConvertFromMaximaToSMath>
<Expression regex="round\((.+)\)" replace="round($1,0)"></Expression>
</ConvertFromMaximaToSMath>

Note that by the time you are reading this, the above translation has been implemented
in the plugin.

round (100-2; 0)
100

ﬁ[rnund[a; 2]]=

"REeceived Bytes: 33
MaximaLog (#)= (¥i27) roundZ(z,2):

(2027) 'round(100*a)/100"
AL (round(m; 3))=3,142

"BEeceived Bytesz: 24
MaximaLog (#)= ($128) roundZ(%pi,3):

(¥o028) 1571/500"
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2 -15-1-05% 005 1 15 2

X

explicit (round(x; 0); x; —2;

2

)

The plot above is generated using a Maxima Draw2D() plot region.
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